
Configuring Eudora

To send and receive messages, you must have an account on a computer running a POP (Post Office Protocol) 
server, and access to a computer running an SMTP (Simple Mail Transfer Protocol) server. Your incoming e-mail 
messages are delivered to the POP account, where you pick them up and transfer them to Eudora on your PC. 
Your outgoing messages are sent to the SMTP server to deliver to your recipients.

If you just installed Eudora and have opened it for the first time, the Getting Started Options are displayed. This
is where you enter the required e-mail account information.

POP account 
Real name    
Connection Method    

If your POP and SMTP servers are on the same computer, you do not need to specify an SMTP server. If they 
are not on the same computer, click on the Hosts category and enter in the SMTP field the full name of the 
computer running the SMTP server.

You are now ready to send and receive e-mail. If you have additional POP accounts, use the Personalities 
Options to specify information about them.



Registering Your Copy of Eudora

Depending on the software license you have for Eudora, you may be eligible for technical support directly from 
the Eudora Technical Support group. To receive technical support, you must register your copy of Eudora Pro in 
accordance with the terms defined in your license Agreement. If you have a previous version of Eudora Pro, you 
need to register this new version.

Note: If you are part of a site license, you do not need to register. Contact your organization’s e-mail 
administrator for support.

If you are eligible for technical support, you are prompted to register after you send the first message with your 
new version of Eudora Pro. Complete the registration form and click Register. The registration is put in the 
queue in your Out mailbox and is sent the next time you send queued messages.

If you don’t want to register at that time, you can choose Not Now to be prompted 7 days later, or Never 
Register to never be prompted again. At any time, you can choose Register Eudora... from the Help menu to 
display the registration form. 



Quitting Eudora

To quit Eudora, select Exit from the File menu. If you have queued messages, or timed messages due to be
sent in the next 12 hours, you are given the option to send them. 
The Trash mailbox is emptied if the Empty Trash on Quit option is on in the Miscellaneous Options.



Uninstalling Eudora Pro

You can uninstall Eudora by using the tools provided with your Windows operating system. 

In Windows 95, open the control panel, double-click on Add/Remove Programs, select Eudora Pro, and click 
Remove. 

In Windows NT, open the Eudora Pro program group from within the Program Manager, then double-click on the 
Uninstall Eudora icon.



Creating an Outgoing Message

An outgoing message is a message you send to someone else. 

To create an outgoing message, select the appropriate command from the Message menu. A new message 
window is displayed, referred to as the Composition Window. 
Using an Alternate E-Mail Account 
Replying to a Message 
Forwarding a Message 
Redirecting a Message 
Sending Rejected Messages Again 
Using the Quick Recipient List  
Using Stationery 
Attaching a File to a Message 



Using an Alternate E-Mail Account

You can set up alternate e-mail accounts, or “personalities,” for each e-mail account you have, and send and 
receive messages for all of them. 

Setting Up Personalities 
Creating a New Message as a Personality 



Setting Up Personalities

To set up your personalities, open the Personalities Options and specify the following options for each 
personality: a name for the personality, your real name, and your POP account. You can also specify the following:

Default domain 
Return address    
SMTP server    
Default signature    
Default stationery    
Check mail    
Leave mail on server    

The rest of the Options categories cannot be changed for specific personalities, they are effective for all. 
However, alternate personalities are automatically set to use a Winsock connection and password 
authentication, regardless of how those options are set in the Getting Started and Checking Mail Options.

If you want to change other options, or use a separate set of mailboxes for an account, see Putting Multiple 
Users on One PC.



Creating a New Message as a Personality

To create an outgoing message as an alternate personality, hold down the shift key and select one of the 
message creation commands from the Message menu (New Message, New Message To, etc.). The Message 
Options dialog is displayed. 

Note: The New Message With and Reply With commands will not display the Message Options dialog. If you 
want to open a stationery message with an alternate personality, select a stationery in the Message 
Options dialog.

Select the personality you want to use (and a stationery if you want), then click OK. The Composition 
Window is displayed with the alternate personality as the sender (and any stationery information if 
requested). 

The default signature for that personality is used, or if you chose a stationery the signature for that stationery
is used. However, you can always change the signature with the popup menu in the message toolbar (for 
details, see Using a Signature). 



Using Stationery

Stationery files are templates for outgoing messages. If you find yourself repeatedly sending the same message, 
save the message as a stationery file and send it whenever you need to using the New Message With or Reply 
With commands. This way you don’t have to copy and paste text into a message, you can just open a pre-written
message and edit it as necessary.

Creating a Stationery File 
Changing a Stationery File 
Creating a Message with Stationery    
Using a Stationery File for all Outgoing Messages 

You can also set up filters to reply with stationery messages. For more information, see Filtering Messages.



Changing a Stationery File

To change a stationery file, open a new message with that stationery file, make your changes, then use the Save As 
option again to save your changes. To delete a stationery file, remove it from the Stationery directory.



Creating a Message with Stationery

To send a stationery message, select the stationery you want from the New Message With or Reply With submenus
from the Message menu. A Composition Window is displayed containing the toolbar, header, and body from the 
stationery file. If you are replying to a message, the stationery is incorporated into the reply. You can edit and send 
this new message just as you would any other message.

The stationery message toolbar overides any of the Sending Mail or Personality options, such as the default 
signature, but you can change them once you open the message.



Using a Stationery File for all Outgoing Messages

To use a particular stationery file for all of your outgoing messages, select a stationery in the Sending Mail Options 
(only for your “dominant” personality), or in the Personalities Options (for any of your personalities). 

If a default stationery file is set, all new messages use this stationery except those created using the Redirect or 
Send Again command.

The message toolbar you defined for the stationery overides any of the Sending Mail or Personality options, such as 
the default signature, but you can change them once you open the message.



Using a Signature

A signature is a few lines of text that are automatically added to the end of an outgoing message when it is sent. 
A signature can be whatever you want, but it is mostly used to give contact information (telephone, address, 
etc.). You can have as many signatures as you want. 

Note: Your signature is not displayed in the Eudora message window, but is added to the end of the 
message when it is sent.

Creating and Modifying the Standard Signature 
Creating and Modifying Additional Signatures 
Deleting a Signature 
Including a Signature in Messages 



Creating and Modifying the Standard Signature

To create or modify your Standard signature, select Standard from the Signatures submenu from the Tools menu. 
The Signature window is displayed. Enter your signature text, and select Save from the File menu to save your 
changes. 



Creating and Modifying Additional Signatures

To create additional signatures, select New from the Signatures submenu from the Tools menu. An alert is 
displayed, asking you what you want to call it. Enter a name and click on OK to display a signature window. Enter 
your signature, save the file, and close the window. Your new signature is now part of the list of signatures.

To modify an additional signature, select the additional signature from the Signatures submenu from the 
Tools menu. The signature window is displayed for the signature you specified. Make any changes you want, save 
the file, and close the window. To remove a signature, drag the file from the Signatures directory into the Recycle Bin 
on your desktop.



Deleting a Signature

To delete a signature, select Delete from the Signatures submenu. A dialog is displayed with all of your signatures. 
Select the signatures that you want to delete, and click OK.



Including a Signature in Messages

To include a signature in an outgoing message, select the signature you want from the Signature popup on 
the message toolbar. 

To include a particular signature in all of your outgoing messages, select a signature in the Sending Mail 
Options (only for your “dominant” personality), or in the Personalities Options (for any of your personalities). 

If you have a default signature set, you can change it for a particular message by selecting a different 
signature from the popup menu on the message toolbar. 



Setting the Message Priority

You can assign a priority to incoming and outgoing messages. The priority is only for you and your recipients—it 
does not affect the way mail transport systems handle the messages. 

There are five priority levels available, 1 being the highest, 5 being the lowest. Each is represented by a small 
symbol in the icon bar of a message window and the Priority column of a message summary. Priority 3 is used 
for messages that have no assigned priorities, and it is not displayed. The high and highest priority symbols are 
red. 

New messages are created with a Normal priority. 

To change the priority of the current message, use the Priority popup.
Note: To set up Eudora to always use the sender’s priority on your replies, turn on the Copy originals 

priority to reply option in the Replying Options. You can always change the priority in the message 
window.



Requesting a Return Receipt

To request that your recipients notify you when they have seen your message, click on the Return Receipt 
icon in the message window. 
When your recipients open the message then close it, a dialog is displayed asking them to create a notification 
message now, later, or never (if you sent yourself a copy, you will not get the notification request). If a recipient 
chooses to create a notification message, it is sent to you and tells you when the recipient displayed your message.

These Return Receipt options may or may not work as described, depending on your recipients’ e-mail software. 



Word Wrap

If you turn on the Word Wrap icon in the composition window, carriage returns are inserted automatically when 
the message is sent, at roughly 76 characters per line. This makes the message legible on the recipient’s 
computer.

It is a good idea not to include your own carriage returns within paragraphs if you have this option on. Only use 
carriage returns to create new paragraphs.

To manually wrap text, select the text you want, then select Wrap Selection from the Edit menu. To unwrap 
text, select the text you want, then hold down the Shift key and select Wrap Selection from the Edit menu. 

To copy wrapped text without taking the carriage returns, hold down the Shift key and select Copy from the 
Edit menu. 



Attaching a File to a Message

Any file can be attached to and sent with a Eudora message. Most attached files function like “riders” to the e-
mail message, and are not included in the body of the message.

When the message is sent, it is encoded in the selected attachment type:

MIME 
BinHex 
Uuencode
Quoted-Printable (QP) 

If you send an attachment to someone who doesn’t use Eudora, the attached file will probably be included at the 
end of the message in the chosen encoding method (MIME, BinHex, or Uuencode), which look like a jumbled 
mess. Your recipient should save the message as a file, then decode the file using an application appropriate for 
the encoding method.

To make a plain text file function as a regular attachment, turn on the Text as Attachment button in the 
message window. (Otherwise, the text of the file is included in the body of the message.) You can make this the 
default if you turn off the Put text attachments in body of message option in the Attachments Options. (This sets 
the Text as Attachment button to on in the message window.)

To attach a file to a current outgoing message, select Attach File from the Message menu. A standard file 
dialog is displayed. Find the file you want, select it, and click on the Attach button to attach the document to the 
message. The name of the document is displayed automatically in the Attachments field. You can add as many 
attachments as you want.

You can also drag one or more files from the Desktop onto the message window to attach them.

To detach a document before the message is sent, select the document in the Attachments field, then 
press the delete key or select Clear from the Edit menu.



MIME

This encoding method is best for recipients with MIME-compliant e-mail readers, regardless of what operating system
they are using. 



BinHex

This is best for recipients on a Macintosh with an e-mail reader that is not MIME-compliant. 



Uuencode

This is best for recipients using PC or Unix systems that are not MIME compliant. 



Including a URL in a Message

To include a URL (Uniform Resource Locator) in a message, enclose it with less than and greater than signs
to ensure that your recipient’s application can identify it as a URL. 

For example, <http://www.eudora.com/>. The URL is automatically highlighted as an active URL in your 
message window.



Checking Your Spelling

Eudora includes a built-in spelling checker. It can be used to check for misspellings in the body of current 
message composition windows, text files, and signature files.    It includes a built-in dictionary and also allows for 
the creation of a custom user dictionary.    Additionally, it can be configured to ignore capitalized words, words 
with numbers, and mixed case words, to report mixed case and doubled (repeated) words, and to suggest 
alternative spellings.    

Note: Changes to the spell checking options can be made in the Spell Checking Options or by selecting 
Options from the Check Spelling dialog.

See Appendix A of the user manual for information on how to get dictionaries for languages other than English.

To check the spelling of a current composition window, text file, or signature file, click on the Check Spelling
button in the main window toolbar or select Check Spelling from the Edit menu.    If there are no misspellings, the No
misspellings found alert is displayed.

Note: If text is selected, Eudora only checks the spelling of the selected text.    Otherwise, it starts the 
spelling check from the beginning of the message body or text file and checks the entire text.

If a misspelled, unknown, or repeated word is found, the Check Spelling dialog is displayed with the word 
listed in the Unknown field.

To correct the misspelled word, type the correct spelling of the word in the Change To field, select it from 
Suggestions list and click the Change button, or double-click it in the Suggestions list.    The spelling checker then 
proceeds with the check. 

To automatically check spelling when you send or queue a message, turn on the Check on queue option in 
the Spell Checking Options. 

If this is on, when you send or queue a message the message is checked for spelling errors. If you go 
through the spell checking process, the message is automatically sent or queued. If you click Cancel, or 
leave spelling errors in the message, a dialog is displayed asking you if you still want to send or queue the 
message. If you don’t want that dialog to be displayed, turn on the Don’t warn me anymore option (this can
also be set in the Spell Checking Options). 



Saving a Message for Later Changes

Sometimes it is convenient to save an outgoing message either as a safeguard when typing long messages, or 
so you can return to it later to make changes. 

To save the current message, select Save from the File menu. 
To save all of the messages that you have open, hold down the Ctrl key and select Save from the File 

menu.
Saved messages are put in the Out mailbox with a bullet () in the Status column. This indicates that the message
has been saved and can be sent or queued.

You can continue making changes or close the message. If you try to close an outgoing message window without
saving that version of the message, an alert is displayed asking if the message should be saved or the changes 
discarded. If you select Discard and the message has never been saved, the message is deleted. 



Sending a Message Immediately

If you want to send your messages immediately instead of putting them in a queue to send later, then be sure the
Immediate send option is on in the Sending Mail Options. 

To send the current message, click on the Send button or select Send Immediately from the Message 
menu. A progress window is displayed to show the progress of the transmission. 
If you have the Immediate send option on, but want to put the current message in the queue, hold down the 
Shift key and click on the Send button. The Change Queueing dialog is displayed and you can set detailed 
instructions. For more details, see Queueing a Message to Send Later or Queueing a Message to Send at a 
Certain Time. 



Queueing a Message to Send Later

If you want to put your messages in a queue (in the Out mailbox) to send all together at a later time, be sure the 
Immediate send option is off in the Sending Mail Options.

You can set up Eudora to warn you if you try to delete a queued message, or try to quit Eudora with queued 
messages. To do this, turn those options on in the Extra Warnings Options. 

To put the current message in the queue, click on the Queue button or select Queue Message from the 
Message menu. The message window is closed (if it was open) and the message is saved in the Out mailbox 
marked Q (meaning it’s ready to be delivered).
To send all of your queued messages, select Send Queued Messages from the File menu. A progress window 
is displayed momentarily at the top of the screen indicating the progress of the transmission. 

If you have the Immediate send option off, but want to send a message immediately, hold down the Shift key 
and click on the Queue button. The Change Queueing dialog is displayed and you can select the Send 
message Right Now option. 



Queueing a Message to Send at a Certain Time

To specify that a message be sent at a certain time in the future, select a message then select Change 
Queueing... from the Message menu. The Change Queueing dialog is displayed.

If you choose Right Now, the message is sent immediately when you click OK. If you choose Next time 
queued messages are sent, the message is queued in the Out mailbox with a Q in the status column and 
sent the next time queued messages are sent. 

If you choose On or After, you can use the Time and Date fields to fill in the time and date when the 
message should be sent. The message is saved in the Out mailbox with a T in the status column, and is 
sent when the specified time arrives.

Note: For the message to be sent at the correct time, Eudora must be running at that time. If Eudora is not 
running, the message is sent the first time Eudora is run after the specified time has passed.

If you choose Don’t Send for a message that has never been queued, nothing happens. If the message has
been queued already, the message status is changed from queued (Q) to saved (). The message is held in 
the Out mailbox until it is either deleted or re-queued and sent. 



Editing a Queued Message

To edit a queued message, open the Out mailbox and double-click on the message summary. Make the 
necessary edits and save them. The message is kept in the Out mailbox. If you close the changed message without 
saving it, an alert is displayed asking you to verify the changes. 



Taking a Message Out of the Queue

A message that is queued but is not yet sent can be unqueued using the Change Queueing command. 

To do this, open the Out mailbox and select the desired message summary. Then, select Change 
Queueing... from the Message menu and click on Don’t Send. This changes the message status from queued (Q) to
saved (). The message is held in the Out mailbox until it is either deleted, re-queued, or sent. 



Sending Queued Messages When Checking Mail

If the Send on check option in the Sending Mail Options is on, every time Eudora checks for mail (automatically 
or manually), all queued messages are automatically sent. 



Sending Messages with Special Server Instructions

To send your queued messages with special instructions for the server, hold down the Shift key and select 
Send Queued Messages from the File menu. The Mail Transfer Options dialog is displayed. Set the options you 
want and click OK. 

All the actions you have requested are completed. For details, see Managing Your Mail on the POP Server. 



Replying to a Message

To create a reply addressed to the original sender, select Reply from the Message menu. 
To create a reply addressed to the original sender and all of the original recipients, select Reply to All from 

the Message menu. 
A new message window is displayed with all of the sender’s original text quoted in the message body. This text can 
be edited as needed. Additional text can be added to the reply just as to any outgoing message, and the reply can 
then be sent or saved for further changes.

If the sender’s text did not include style information, each line is prefixed by a greater-than symbol (>). 

Quoted text that does not include style information

If the sender’s text did include style information (e.g., bold text), it is quoted with greater-than and less-than symbols 
above it and below it, and a left sidebar.

Quoted text that includes style information

Messages that have been replied to are identified with an R in the Status column of their message summary.



Using the Reply Functions

There are several options that you can use when replying to messages.

To include yourself as a recipient, turn on the Include yourself option in the Replying Options. This only 
works if you are using Reply To All.

Note: To determine who you are, Eudora uses the “me” nickname, if you create one for yourself. If not, 
Eudora uses the contents of the POP account and Return address fields from the Personal 
Information Options.

To put the addresses of the other recipients of the original message in the Cc field (instead of the To field), 
turn on the Put original To recipients in Cc field, not To field option in the Replying Options. Only the original 
sender’s address is put in the To field. This only works if you are using Reply To All.

To copy the original message’s priority to your replies, turn on Copy original priority in the Replying 
Options.

To map Ctrl-R to Reply to All, instead of Reply, turn this option on in the Replying Options.



Replying with a Stationery File

To reply to a message with a stationery file, select a stationery from the Reply With submenu from the 
Message menu. A composition window is displayed with the original text quoted and the text from the stationery 
message below it. 

For details about stationery, see Using Stationery.



Forwarding a Message

Any message can be forwarded to someone else. 

To forward the current message, select Forward from the Message menu. A new message window is 
displayed with your address in the From field, the original sender’s text quoted in the message body, and the original 
attachments in the Attachments field. For details on how text is quoted, see Replying to Messages.

Note: If you forward an outgoing message (a message you sent), the attachment(s) is not included.

Make any changes you want, and enter the recipients’ address in the To field. The message can then be 
sent or saved for further changes.

Messages that have been forwarded are identified with an F in the Status column of their message summary.



Redirecting a Message

Incoming messages can be sent to a new recipient “by way of” you, maintaining the original sender’s address in 
the From field. This is called redirecting. 

To redirect the current message, select Redirect from the Message menu. A new message window is 
displayed with the original sender’s address in the From field with the statement “by way of your address”, the 
original sender’s text in the message body, and the original attachments in the Attachments field. Make any changes
you want, and enter the recipient’s address in the To field. The message can then be sent or saved for further 
changes.

Note: You may want to enclose any changes in brackets ([]) so that you don’t confuse the recipient about 
who wrote what.

Messages that have been redirected are identified with an D in the Status column of their message summary.



Turbo Redirecting

You can redirect one or more message to someone on your recipient list, queue the new message (without 
displaying it), and delete the original message, all with one command. 

To make Turbo Redirect the default menu option, turn on the Turbo redirect by default option in the 
Miscellaneous Options. Then, when you select a message and use the Redirect To command, the message is 
automatically queued in the Out mailbox and the original is deleted. 



Redirect and Signatures

When you use Redirect, your signature is not added to the message when it is sent, unless you originally created
the message. Eudora considers the message to be originally from you if the address in the From field exactly 
matches your return address, or your nickname called “me.” 



Keeping Copies of Outgoing Messages

There are three ways to keep copies of your outgoing messages.

To put a copy of every outgoing message in the Out mailbox, turn on the Keep copies option in the Sending
Mail Options. 

To put a copy of the current outgoing message in the Out mailbox, turn on the Keep Copy icon in the 
toolbar.

To put a copy of the current outgoing message in a particular mailbox, click right in the message body and 
select the mailbox from the Fcc menu.
In all these cases, when the messages are sent they are put in the specified mailbox with S in the Status column,
indicating that the message has been sent. 

If none of these options are used, outgoing messages are put into the Trash mailbox.

Note: You can also set up a filter to save outgoing messages in particular mailboxes based on information 
contained in the message. See Filtering Messages for more information.



Sending Rejected Messages Again

If for some reason an e-mail message can’t be delivered to a recipient, mail transport agents return the message 
to the original sender (you). A message is typically rejected because of an error in the recipient’s address, 
although many other reasons are possible.

The return message usually includes cryptic information that may let you determine the reason the message was
rejected. It also includes the text of the original message. 

You can usually recover the original message, make any corrections, and resend it. 

To do this for the current message, select Send Again from the Message menu. This eliminates the inserted
extra text and reformats the message as it originally appeared. You can then make changes or additions and send 
the message again.



Checking for Mail Automatically

You can set up Eudora to automatically check your POP server(s) and transfer new mail every so often. To do an
automatic mail check Eudora has to be running, but you can be using other applications on your PC.

To set up automatic mail checks:
Open the Checking Mail Options and in the Check for mail every ? minutes option, enter the number of 

minutes that you want between mail checks. For example, if you enter 15, Eudora checks for mail every 15 minutes. 
(15 minutes is a good minimum interval, because checking mail more frequently puts an unnecessary load on your 
POP server.)

Open the Personalities Options and turn on the Check Mail option for each personality that you want to be
checked. The <Dominant> personality is your main account (specified with the Getting Started and other 
Options). 

Note: If automatic checking is set, the Check Mail command under the File menu displays the next time that
an automatic check is scheduled to occur.

The Check Mail option also indicates that the account should be checked when you manually check for new
mail.



Checking for Mail Manually

You can check for mail manually at any time.

To check for new mail, select Check Mail from the File menu. 
Each account that has the Check Mail option turned on (in the Personalities Options) is checked. If you 

haven’t successfully entered your password for an account, you are prompted for it. A progress window is 
momentarily displayed at the top of the screen indicating that an attempt to reach your POP account is being made.

Note: If automatic checking is on and you manually check for new mail, the next automatic mail check will 
happen at the specified number of minutes after the manual check. 



Stopping a Mail Check

If you want to stop a mail check in the middle, click on the Stop button in the progress window or press the Esc 
key.



Using Your Password

Each time you open Eudora and check mail for the first time, you need to enter your password. In the Password 
dialog, type in your password and click OK. If you make a mistake before clicking OK, simply backspace and re-
enter the password correctly. 

Note: Your POP account password is case-sensitive, so the uppercase and lowercase characters must be 
typed in exactly.

If your password is rejected, an error message is displayed indicating that you have entered the wrong 
password. 

Select Check Mail from the File menu to redisplay the password dialog.

As long as Eudora is running, it remembers all of your passwords. If you don’t want it to remember (if, for 
example, you are away from your PC), select Forget Password(s) from the Special menu. The next time you 
check mail for any account, you are prompted for your password again. 

You can also make Eudora remember all of your passwords from one session to the next, which means you 
never have to enter your passwords again, even if you quit and restart Eudora. You only want to do this if your 
PC is in a secure location, where there is no possible chance of someone else having access to it. To use this 
option, turn on Save password in the Checking Mail Options.



Changing Your Password

To change any of your passwords, select Change Password… from the Special menu, and select the 
personality you want to change the password for. You are prompted to enter your old password once, and your new 
password twice. Depending on the server you are using, the password can be up to 30 characters, but normally it is 
only 7 or 8. 

This command only works if the POP server is running a compatible password-change server.
When you choose a new password, try not to use real words, names, dates, familiar acronyms, etc. Some 
systems require at least one number or symbol in your password, and you may want to do that even if it is not 
required.



Receiving New Mail

When Eudora does a mail check, you can be notified of new mail in one or all of the following ways: an alert 
dialog, the opening of the mailboxes to which new mail is delivered, and a special “New Mail” sound. These 
options are turned on or off in the Getting Attention Options.

When you receive notice that new mail has arrived, select Eudora from the applications menu. Mail usually 
arrives in the In mailbox (unless you are using filters to transfer messages). If the In mailbox is not already open, 
select In from the Mailbox menu. The messages are listed in the order they are received, with the most recent 
message listed last. Unread messages are designated by a bullet in the Status column of the message summary.

Double-click anywhere on a message summary to open the message. Incoming messages are saved indefinitely
in the In mailbox (or the mailbox they are filtered into) until they are deleted or transferred to another mailbox.



Receiving Attachments

Unless you have specified a particular folder for your incoming attachments (see Specifying an Attachment 
Directory), they are automatically decoded and saved in the Attach Directory in your Eudora Directory. If you 
receive multiple attachments with the same name, a number is added to the end of each duplicate name, in the 
order they are received. Attachment names and icons are displayed at the bottom of incoming messages. 

To open an attachment from the message window, double-click on the attachment name or its icon. If you 
have the application that the attachment was created in, that application launches and the attachment opens.



Specifying an Attachment Directory

If you do not want to use the default Attachment Directory to receive your attachments, open the Attachments 
Options and click on the large button beneath the Attachment Folder prompt. A standard file dialog is displayed. 

Double-click on the name of the directory you want to use (its name should be displayed in the menu above the 
list), then click the Use Directory button. The dialog closes, leaving the Options dialog displayed. The name of 
the folder you just selected is now displayed in the Attachment Directory button. 

Note: If at any time Eudora cannot find your selected directory, an alert is displayed at startup informing you
that the Attachment Directory is unavailable. Eudora will use the Attachment Directory in the Eudora 
direcotry for attachments until you designate a new directory.



Editing Incoming Messages

You can edit the message body in an incoming message if you turn on the Pencil icon in the message toolbar. 
You can also edit the Subject in the toolbar (this is the subject shown in the message summary). 

To edit an incoming message, click on the Pencil icon to turn it on, then edit the message body. When you 
are done, save your changes and close the message.

To edit the subject of an incoming message, open it and edit the subject in the icon bar (not the subject in 
the message body). When you are done, click somewhere else in the message, or close it. The new subject is 
displayed in the message summary. The contents of the Subject field of the message header remain unchanged.

Note: If you reply to the message, the original subject is used for the reply, not your changed subject.



Using Active URLs

Any string of text that Eudora recognizes as a URL (Uniform Resource Locator: http, ftp, gopher, ph, finger, etc.) 
is active. You can hold down the command key and click on a URL (or just double-click) to open a World Wide 
Web location, transfer a file, do a gopher search, use the finger tool, etc. 

To setup Eudora to automatically open a new message when you use a mailto link within a Netscape Web 
browser, turn on the Intercept Netscape mailto URLs option in the Miscellaneous Options. (Be sure you are not 
running the Mailto Watcher application at the same time.)



Managing Your Mail on the POP Server

During a mail check, your incoming messages are normally transferred from your account on the POP server to 
your PC, and then deleted from the POP server. But this can be awkward if you want to read mail from two or 
more computers, and keep your mail organized at the same time. 

There are several options that you can use to control your mail transfers and the storage on the server. Some of 
these options are available in the Checking Mail Options, and some are available in the Mail Transfer Options 
dialog. 

Leaving Mail on the Server 
Deleting a Message from the Server 
Skipping Messages Over a Certain Size 
Checking for Mail with Special Server Instructions 



Leaving Mail on the Server

To transfer all of your new messages from the POP server to the PC you are on, and also leave copies of 
those messages on the server, turn on the Leave mail on server option in the Checking Mail Options. You can set 
the number of days the copies should be kept, or leave the field blank to store the copies indefinitely. 

Note: The Leave mail on server option can also be set for each additional personality you have. To do this,
use the Personalities Options.

At the next mail check from that PC, Eudora ignores the copies of those previously read messages and looks for 
new ones. However, if you check mail from another computer, those messages are treated as new and are 
transferred to that computer. 

Note: The Leave mail on server option should be used with care, since it can result in a buildup of 
messages on the POP server.



Deleting a Message from the Server

To delete a message that has been left on the server (without retrieving it again), turn on the Trash icon in the 
message toolbar or set the message summary’s server action to Delete, then check mail again. Or, use the 
Delete all messages that have been retrieved option in the Mail Transfer Options dialog (described in 
Checking for Mail with Special Server Instructions).



Skipping Messages Over a Certain Size

To stop Eudora from transferring incoming messages that are too large, turn on the Skip messages over ? 
K option in the Checking Mail Options, and specify a size. Only the first few lines of the messages that exceed that 
size are transferred, with a note at the bottom stating that the whole message has not been transferred. 
If you decide you want to transfer the whole message, click on the Fetch icon in the incoming message window, 
or select the Fetch server action popup in the message summary, then check mail again. You can also use the 
Trash icon or the Fetch & Delete server action popup so that the message is deleted from the server after 
transferring it.

If you decide you don’t want the message and want to delete it from the server, click on the Trash icon in the 
incoming message window, or select the Delete server action popup in the message summary, then check mail 
again.



Checking for Mail with Special Server Instructions

To check your mail and give special transfer and storage instructions to the server, hold down the Shift key and 
select Check Mail from the File menu. The Mail Transfer Options dialog is displayed. Set the options you want 
and click on the OK button to continue checking for mail.

Retrieve new mail  
Send Queued messages 
Delete messages marked for deletion 
Retreive messages marked for retrieval 
Delete all messages that have been retrieved 
Delete all messages on server 
Fetch all message headers to In mailbox 



Message Summaries in Mailboxes

Each line in a mailbox window represents a message and is called a message summary. Outgoing messages 
that are in any mailbox other than Out are shown with italicized message summaries.

To select one or more message summaries, use one of the following options: 

To select one summary, click on it.
To select two summaries and all the summaries between them, select a summary, hold down the Shift key, 

and select another summary.
To make “disjointed” selections, hold down the Ctrl key and select summaries.

Each message summary is divided into columns: Status, Priority, Attachments, Label, Sender/Recipient, Date, 
Size, Server Action, and Subject. You can show or hide these columns using the Mailbox Columns Options.

A message’s Status, Priority, Label, and Server Action can be changed directly in the mailbox window. To do this,
select the messages you want to change and click the right mouse button. Select an option from the popup menu
to make your change.



Displaying and Resizing Columns

To specify which columns you want to be displayed in your mailboxes, open the Mailbox Columns Options 
(from the Tools menu) and be sure the columns you want to see are on. You can also turn the separator lines on and 
off. 

To resize a column in a mailbox window, move the mouse pointer until it is over the column header divider to
the right of the column you want to resize, then press the mouse button, drag the divider to the position you want, and
release the mouse button. The column divider moves to the new location, and the mailbox is redrawn.
You can only shrink a column as far as its left divider. If you do that, a double divider line is displayed in place of 
the column, and its contents are hidden. To redisplay the column, drag the right divider line to the right.



Using the Mailbox Size Display

In the lower left corner of each mailbox window, three numbers show the size information for that mailbox. The 
first is the number of messages in the mailbox; the second is the total amount of space those messages require; 
the third is the amount of disk space that is wasted with the mailbox. 

Wasted space is created when messages are deleted from a mailbox. This wasted space is automatically 
removed when the amount of wasted space in the mailbox is greater than the amount of space the messages in 
the mailbox use, or if the amount of space wasted in the mailbox is greater than 5% of the free space on the 
volume that contains it.

To manually clean up the wasted space in a mailbox, click on the mailbox’s size display. Or, to clean up all 
your mailboxes, select Compact Mailboxes from the Special menu.



Creating a Mailbox or Folder Using the Mailbox Menu

To create a new mailbox or mail folder, select New... from the Mailbox menu. The New mailbox dialog is 
displayed.

You can create a new mailbox or mail folder inside a mail folder by selecting the New… command under a 
folder.

To create a mailbox, type in the new mailbox name and click OK. The mailbox is created and added to the 
Mailbox and Transfer menus.

To create a mail folder, type the name of the new mail folder and check the Make it a Folder option. Click 
OK to create the folder. The new mailbox dialog is displayed again. Type the name of a mailbox to create within the 
new folder, then click OK. The new folder and its mailbox are displayed in the Mailbox and Transfer menus. 



Deleting a Message

As a safeguard against inadvertent deletions, two steps are used to delete a message from your PC: first you put
the message in the Trash, then you empty the Trash.

To put a message in the Trash, select the message then select Delete from the Message menu, or select 
Trash from the Transfer menu, or press the delete key. The message is transferred to the Trash mailbox. 

To delete the messages in the Trash mailbox (removing them permanently from your PC), select Empty 
Trash from the Special menu.

To delete a message permanently without sending it to the Trash first, select the message, hold down the 
Shift and Ctrl keys, and select Delete from the Message menu (or use any of the deleting options). 
You can set up Eudora to warn you if you try to delete unread, queued, or unsent messages. To do this, use the 
Extra Warnings Options to turn on those options.

Quitting Eudora empties the contents of the Trash mailbox when the Empty Trash when exiting option in the 
Miscellaneous Options is turned on. Finally, if you want to delete just a few messages from the Trash mailbox, 
select them, then select Delete from the Message menu or press delete. Deleting a message from the Trash 
removes it completely.



Automatically Deleting Attachments

When you delete messages, you can have their attachments automatically deleted. 

To delete any attachments of messages that are emptied from the Trash, turn on the Delete attachments 
when emptying Trash option in the Attachments Options, and be sure the attachments are still in the Attach 
Directory (or the directory you have specified for attachments). 

To delete any automatically generated message’s attachments (such as with the Insert System 
Configuration command), turn on one of the Delete automatic attachments options in the Attachments Options. 

If you have this option on, and want to delete a message but save its attachment, move the attachment into 
another folder before deleting the message.



Transferring Messages

You can transfer messages to any of your mailboxes. There are several ways to do this: 

Using the Transfer menu 
Dragging Messages 

To put a copy of a message in another mailbox (instead of transferring the message), hold down the Shift 
key and use one of the transfer options above. This is useful if you want to file a message in more than one mailbox.
If you try to transfer a message to the Out mailbox, an alert is displayed informing you that some header 
information may be removed from the message during transfer. Click Yes to transfer the message.

Note: You can undo mailbox transfers using the Undo command under the Edit menu.



Using the Transfer menu

The Transfer menu is one way to transfer messages among your mailboxes. With a current message open, or 
message summaries selected, select a mailbox from the Transfer menu. The messages are transferred from 
their previous mailbox to the mailbox you selected.



Dragging Messages

You can drag messages from one mailbox to another using the message summaries or the Tow Truck icon in an 
open window. 

To drag a message summary to another mailbox, select the message summary (or summaries), place the 
cursor over the summary, and hold down the mouse button. Drag the summary into any open or minimized mailbox 
window, or (if you are using the 32-bit version)any mailbox in the Mailboxes window, or any toolbar mailbox button 
you have created (see Customizing the Toolbar). When you release the mouse button, the message is transferred.

To drag an open message to another mailbox, hold down the mouse over Tow Truck icon and drag the 
message into any open mailbox, any mailbox in the Mailboxes window, or any toolbar mailbox button you have 
created. When you release the mouse button, the message is transferred.



Creating a Mailbox or Folder During Transfer

To create a mailbox and transfer the current message into it at the same time, select New... from the 
Transfer menu instead of the name of a mailbox. The New Mailbox dialog is displayed. Enter the name of the 
mailbox or mail folder (be sure to check the Make it a folder option if you want a folder), and click OK. The current 
message is transferred into the new mailbox. 

To create the new mailbox without transferring the message into it, check the Don’t transfer, just create 
mailbox option. 



Filtering Messages

Many of the e-mail management functions in Eudora Pro can be done automatically using filters. For example, 
you can automatically reply to a request for information, transfer all the messages from your children into a 
Personal mailbox, and label all the messages from your customers as “Hot.” 

To open the Filters window, select Filters from the Tools menu. The Filters window is displayed, and any 
filters you have created are listed on the left.

To create or modify a filter, first click on the New button or select an existing filter. 
Second, select the options for how you want the filter to be used: as an automatic filter to be invoked on any 
Incoming and/or Outgoing mail, and as a Manual filter that can be invoked when you select Filter Messages 
from the Special menu. Any combination of these options works.

Third, define the criteria for the filter: use the header item popups and the text fields to specify which header 
items should include a particular string of text. Use the conjunction popup to define two related terms for the 
criteria so that your filter is as specific as possible. 

Header
Match Type 
Matching Text
Conjunction    

Fourth, Define the action to be taken on messages that fit the criteria and save the filters. 

Filter Actions 

Note: Filters are automatically named based on the criteria for the filter. You can re-order them using the Up
and Down buttons above the list.

When the filters are invoked (automatically or manually), each message is matched against each filter in order 
from top to bottom. If the message meets a filter’s criteria, the actions are done as specified until there are no 
more actions, then the message is matched against the next filter. If at any point a Skip rest action is done, 
nothing else is done with that message, and the next message is filtered.

When an incoming message with a precedence header of list or bulk is filtered, no new outgoing messages are 
not created. This prevents automatic messages from being sent to mailing lists, people who have a vacation 
response set, etc. 

You can change the width of the filters list to create more or less space for your list. To do this, put the arrow over
the bar to the right of the list and drag the line to the left or right.



Sorting Messages Within Mailboxes

The message summaries in mailboxes are automatically sorted by date, in ascending order (the newest 
messages at the bottom of the mailbox). 

To change the sort, select the appropriate command from the Sort submenu from the Edit menu. Or, click 
on any of the column headings to sort by that column. To sort in descending order, hold down the Shift key and select
a sort command. 
Each sort is based on the previous state of the mailbox. For example, if a mailbox is sorted by date, and then you
sort by sender, the messages are grouped by sender and each group is in order by date. 

Note: Sometimes sorting by Date can be incorrect. This usually happens if the messages have incorrectly 
formatted date fields, or unknown or incorrect time zones. 



Finding Text Within One Message

To search for text within a single message, open the message and make sure it is current.    Then, select 
Find from the Edit menu and select the Find command from the submenu.    The Find dialog is displayed, with the 
blinking insertion point located in the text field.    

Type the text you want to find in the text field.    When finished entering the desired text, click the Find 
button.

Starting at where the cursor is in the message, Eudora searches the current message for the specified text.   
If no match is found, the not found alert is displayed.

If the search is successful, the message is scrolled to the first point where the match is found and the 
matching text is highlighted.

To continue searching in the same message for the next occurrence of the text, click the Find button in the 
Find dialog, or select the Find Again command from the Find submenu.    These commands are equivalent and limit 
the search to the same message.    Repeating these commands cycles through the matches in the open message 
only.
Match Case 
Summaries Only 



Finding Text Among Multiple Messages and Mailboxes

To continue to search for text in the messages following the current message, and within the same mailbox, 
click on the Next button. 

To continue to search for text in the messages following the current message, and to go to the next mailbox 
if necessary, Next Message button. 

To continue to search for text in the messages in the next mailbox, click on the Next Mailbox button. 
Note: Mailboxes are searched in the same order as they appear in the Mailbox menu.



Enter Selection Command

If you don’t want to actually type the text in the Find dialog (for example, the text is very long or complex), 
highlight it in an existing message, and then select Enter Selection from the Find submenu.    This automatically 
inserts the selected text at the insertion point in the Find dialog.    Then, select the Find command from the Find 
submenu to start the search.



Stopping a Find

If you want to stop Eudora from continuing a search, click the Stop button on the progress window or press the 
Esc key.    



Saving a Message to a File

You can save a message to a separate text file on your PC. 

To do this, open or select the messages you want to save to text. Then, select Save As... from the File 
menu. The Save As dialog is displayed allowing you to choose a name and location for the file. 

Be sure the Type is Text Files, enter the name you want to give the text file, and select the appropriate 
options.

Guess Paragraphs removes extraneous carriage returns from the message, leaving returns only at the ends of 
paragraphs, and converts multiple spaces into tabs. 

Include Headers retains the first message’s header information in the saved document. If this is not checked, 
only the body of the messages is saved. 

Stationery saves the message as a “stationery” file. This option may not be available (depending on the 
message you are saving). For details, see Using Stationery.

Once you’ve made all of your choices, click on the Save button in the dialog. 

Note: If an unread (•) message is saved to a file, its status changes to read, regardless of whether the 
message was opened.

If you select multiple messages from a mailbox window and select Save As..., all of the messages are saved to a
single file with only the header from the first listed message.



Using the Address Book

The Address Book is where you keep information about individuals or groups that you correspond with. Each 
entry in the Address Book includes a nickname for a person or group, their full e-mail addresses, a real name, 
any contact information, and any notes. You can also use the Address Book to put nicknames on the Quick 
Recipient List, and to address a new message.

To open your Address Book, select Address Book from the Tools menu. 
All of the Address Book entries are kept in files. Eudora Nicknames is the default file, but you can use additional 
files to organize your entries.

You can use the View By option to display the entries using any of the fields except the Notes field. For 
example, if you want to view the entries by nicknames, select View By Nicknames. If you view by a field that 
doesn’t contain any data, the entry is displayed with «».

You can also start typing in the list of entries and the appropriate entry will be selected when you enter enough 
unique characters to identify it.

To page up and down in the list of entries, use the arrow keys. To resize the list, drag the divider. 
Creating New Entries
Changing and Removing Entries
Including Nicknames on the Quick Recipient List
Addressing a Message from the Address Book
The Make Address Book Entry Command
The Finish Address Book Entry Command
Using Nicknames that were not Created by Eudora
 Using the Quick Recipient List



Creating New Entries

To create a new file of Address Book entries, click New. A dialog is displayed asking what you want to call it. 
Enter a name for the file and select Make it a file, then click OK to create it. The file is displayed in the list, 
and you can now add entries to the file.

To create a new entry to be included in an existing file, click on New. A dialog is displayed asking what you 
want to call it. Enter a Nickname for the entry. A Nickname (sometimes called an alias) is an easily remembered, 
shorter substitute for the e-mail addresses in the entry. Nicknames can be used in place of proper e-mail addresses 
in the To, Cc, and Bcc fields of outgoing messages. 

Specify which file this entry belongs in (if you have multiple files), and select the Put it on the recipient list 
option if you want the nickname on your list. You cannot create a file within a file, so do not use the Make it a
file option. Click OK to create the entry. Then you can enter the information for that entry.

In the Address(es) field, enter the complete e-mail addresses of the people (or person) to be included in the
nickname, separating the addresses with commas or returns (this is the only place you can use a return to 
separate addresses). You can also use nicknames in this field, but be sure that any nicknames you use are 
defined in their own entry. You can use a mix of nicknames and complete e-mail addresses. 

Note: Be sure there is no other information in this field except addresses or nicknames, or your messages 
will be addressed incorrectly. 

In the Name field (in the Notes tab),    enter the real name of the person or group. If there is just one address
for the entry, the real name and the address is included in the To field for your recipient to see. If there is 
more than one address for the entry, the real name is the only thing included in the To field for your 
recipients—they do not see the whole list of recipients.

In the other fields provided in the Info and Notes tabs (Phone, Fax, Postal Address, and Notes),    you can
enter contact information for the person or group, and any notes to yourself. This information is not included 
in outgoing messages.

To save your changes to the Address Book, select Save from the File menu.



Changing and Removing Entries

To make changes to an Address Book entry, select the entry from the list and edit the fields as appropriate. 
Important:    If you change a nickname, but sure to correct any entries that reference that nickname.

To remove an entry or an address file, select it from the list and click on the Remove button or the Delete 
key. You cannot remove the Eudora Nicknames file.

To save your changes, select Save from the File menu. 



Including Nicknames on the Quick Recipient List

To include a nickname in the Quick Recipient List, select the appropriate Address Book entry from the list 
and click on the Recipient List option (next to the Nickname field). 

The nickname for the selected entry is included on the Quick Recipient List. If you change a nickname or 
remove an entry, the Quick Recipient List is updated as appropriate. For details about using the Quick 
Recipient List, see the section “Using the Quick Recipient List.”

Note: You can add or remove mulitple nicknames to or from the Quick Recpient List by selecting multiple 
entries. Hold down the Shift key to select multiple entries in sequence, or the Ctrl key to make disjoint 
selections.

To save your changes, select Save from the File menu. 



Addressing a Message from the Address Book

You can open and address a new message from the Address Book using the To, Cc, and Bcc buttons, or by 
dragging one or more entries to an open message. 

To create a new message from the Address Book, select the entry to which you want to address the mail 
(hold down the Shift key to select multiple entries in sequence, or the Ctrl key to make disjoint selections). Then click 
on To, Cc, or Bcc. A new composition window is displayed with the selected nickname(s) inserted in the appropriate 
field.

Note: You can also double-click on one entry to enter that nickname in the To field, or double-click on one 
of many selected entries to enter those nicknames in the To field). 

To address the message with the addresses from the Address(es) field (instead of the nickname), turn on 
the Expand Nicknames option.
Once the composition window is displayed, you can use the To, Cc, and Bcc buttons to insert additional 
nicknames into the corresponding fields. Or, you can drag the appropriate entries to those fields.



The "Make Address Book Entry" Command

The Make Address Book entry command is used to create entries in your Address Book, and is especially helpful
for making group entries. You can use this command from almost anywhere in Eudora.

In the Address Book, highlight several different entries (hold down the Shift key to select multiple entries in 
sequence, or the Ctrl key to make disjoint selections), then select Make Address Book Entry... from the Special 
menu. The New Nickname dialog is displayed prompting you for the nickname of the new entry. The Address(es) 
field of the new entry will include the nicknames for the entries you selected, not the real addresses.

In a mailbox, highlight the message(s) you want and select Make Address Book Entry... from the Special 
menu. The New Nickname dialog is displayed prompting you for the nickname of the new entry. Follow the 
instructions for creating a new entry. 

If the current message is an outgoing message, the new entry will include all of the addresses in the To, Cc, 
and Bcc fields. If the current message is an incoming message, the new entry will include the address in the From 
field. If multiple messages are current (i.e., you have several message summaries selected in a mailbox window), 
addresses are taken from each message and are all put in the new entry.

Note: If the Include yourself option is on in the Replying Options, your address is included in the new 
entry.

In the Directory Services window, finish a Ph query and select Make Address Book Entry... from the Special 
menu. The New Nickname dialog is displayed so that you can name the nickname. The real name and e-mail 
address are included in the new entry.



The "Finish Address Book Entry" Command

With the Finish Address Book Entry command, you can enter a unique portion of a nickname in the To, Cc, or 
Bcc fields of a message, then select Finish Address Book Entry from the Edit menu, and the nickname will be 
completed for you. You must enter the characters in the nickname that make it unique, or Eudora will not know 
which nickname to use. For example, if you have two nicknames, jon and john, you would have to enter “jon” or 
“joh” for Eudora to complete them. 

To insert the real addresses for the entry, instead of the nickname, hold down the Shift key and select Finish
Address Book Entry from the Edit menu. To set this to happen all the time, turn on the Automatically expand 
nicknames option in the Miscellaneous Options.



Using Nicknames that were Not Created by Eudora

To use a nickname file that was not created in Eudora, put the file in the Nickname directory (in your Eudora 
directory), and be sure the format is as follows: One nickname on each line with the real addresses separated by
commas, and one line for notes and info with the Notes text following the Info data. For example:

alias Wow joe@wow.com,lisa@wow.com,chris@wow.com
note Wow <fax: 222.2223><phone: 222.2222><address:1234 Street>

<name:Wow Inc.>My favorite company

You will need to exit and re-open Eudora to see your new entries in the Address Book.



Using the Quick Recipient List 

The Quick Recipient List is your list of often-used nicknames. If you have checked the Recipient List option in an 
Address Book entry, the entry’s nickname is included in the list. 

To open a new message addressed to someone on your Quick Recipient List, select New Message To, 
Forward To, or Redirect To from the Message menu, and select the nickname from the displayed list. 

To insert a nickname into a message that you have already opened, put the cursor where you want the 
nickname and select Insert Recipient from the Edit menu. 

To insert the real address(es), instead of the nickname, hold down the Shift key and select Insert Recipient 
from the Edit menu. To set this to happen all the time, turn on the Automatically expand nicknames option in the 
Miscellaneous Options.
More than one nickname from the Quick Recipient List can be added to the To, Cc, and Bcc fields of any 
message. If you use the Insert Recipient command, commas are added where necessary. 



Opening Directory Services

Eudora can access two different directory services, Ph and Finger. To use these services, you must put the name
of the host machines for the Ph and finger servers in theHosts Options.

To use the directory services, select Directory Services from the Tools menu.
Using Ph 
Finding Ph Servers 
Using Finger 
Addressing a Message from the Address Book 



Using Ph

To look someone up using Ph, enter your command and click on Ph. The command is sent to your Ph 
server, and the response is displayed in the lower section of the window. 

To add the results of your Ph command to your Address Book, specify which of the results you want to 
include in the Address Book, then select Make Address Book Entry… from the Special menu (for details on how to 
use this command, see The Make Address Book Entry Command). This may not work if your Ph server is not set up 
for it.

Note: You can type any Ph command in the query field, except login commands or commands requiring 
login. For information about the Ph server source code, see Appendix A.



Finding Ph Servers

Some Ph servers keep a list of other Ph servers that are available on the Internet. This is not always a 
comprehensive list of every Ph server out there, but it can be helpful.

To get the list of servers that the active server knows about, click on the Server button. A list of servers is 
displayed in the results area. To go to one of those servers and do a query, double-click on the server’s URL. 



Using Finger

To use the Finger protocol, enter your command and click Finger. The command should be in the form 
“name@domain.” If you omit the “@domain” segment, the active server is used. The finger command is sent to 
the finger server, and the response is displayed in the lower section of the window.



Addressing a Message from the Directory Services Window

You can create and address a message with the command results in the Directory Services window. 

To create a new message, be sure there are no outgoing messages already open, do the Ph or Finger 
command, and put the cursor on the addresses you want (if you don’t do this, all of the found addresses are used). 
Then click on the To, Cc, or Bcc button. A new message is created, and addressed appropriately with the query 
results. 

To add an address to an existing message, make sure the message you want to address is active, open the 
Directory Services window, do the Ph or Finger command, put the cursor on the addresses you want. Then click on 
the To, Cc, or Bcc button. The address from the query result is added to the appropriate field of the current message.

To keep the Directory Services window on top so that you can easily continue using it, turn on the Keep on 
Top option at the bottom of the window.



Printing

You can print the current message or messages, a plain text window, selected text within a message or text 
window, the contents of the Directory Services window, and your filters. Eudora automatically prints headers and 
footers on each page, giving the window title, page number, and your return address.

To print the current message or item, select Print... from the File menu. 



Plugins (Extended Messaging Services)

Plugins are special add-ons that can be installed to add features to Eudora. For example, you could use a 
language conversion plugin to translate a message to another language, a security plugin to automatically 
secure a message, or a compression plugin to compress a message and its attachments. Plugins interface to 
Eudora using the Extended Messaging Services Application Programming Interface (EMSAPI). 

To make plugins available to Eudora, put them in the Plugins directory in your Eudora Pro directory, then 
restart Eudora. Some will show up in the Message Plugins submenu in the Edit menu, others will show up as icons 
in message windows. 

To see all of the currently installed plugins, select Message Plugins Settings from the Special menu. If a 
plugin has any settings options, you can use the Settings button to change them.    
For information about available plugins, send e-mail to <quest-rep@eudora.com> or visit the World Wide Web 
site <http://www.eudora.com/>.



The Messaging Application Program Interface (MAPI)

MAPI is an interface that lets you send e-mail messages from any MAPI-compatible application, such as your 
word processor, spreadsheet, graphics application, etc. 

MAPI-compatible applications have a Send or Send Mail option in the File menu. When you select the option, 
the Eudora MAPI server displays a new outgoing message with your current document attached. All you need to 
do is address the message, type any details you want to include in the body of the message, and click Send or 
Queue. 

To run the Eudora MAPI server, use the MAPI Options dialog. To display the MAPI Options dialog, select 
Options... from the Tools menu and click on the MAPI category (see the “Options Dialog, MAPI” section). 
You have several options in the MAPI Options dialog for loading the Eudora MAPI server. You can set it to 
always run or to run only when Eudora is running, or you can specify that it never run. These three options open 
or exit the server as soon as you select them.

Note: When you are running the Eudora MAPI server, Microsoft Exchange will not work. If you need to use 
Exchange, turn off the Eudora server. 

See Appendix F for technical details on the Eudora MAPI server.

You also have several options for saving or deleting MAPI attachments. When you use MAPI to attach a file and 
send a message, that file is immediately copied into the Attach directory (or a directory you have specified). You 
can use the MAPI options to save those copies, delete them after sending their corresponding messages, or 
delete them after their messages are emptied from the trash.



Modifiers

Many operations in Eudora can be implemented by holding down one or more modifier keys. Eudora uses the Shift, 
Ctrl, and Alt keys as modifiers.

Shift + Check Mail or Send Queued Messages
Display the Mail Transfer Options dialog to define the interaction with your POP 
account.

Shift + Queue/Send Open the Change Queuing dialog.

Shift + New message command
Display the Message Options dialog to select a personality and stationery for the new 
message.

Shift + Open an incoming message
Opens the message with all headers displayed.

Shift + Insert Recipient Insert the address(es) instead of the nickname.

Shift + Ctrl + ,      or        Shift + Finish Address Book Entry
Finish the Address Book entry with the address(es) instead of the nickname.

Shift + Sort command Sort in ascending order.

Shift + Transfer Put a copy of the current message in the selected mailbox and leave the original where 
it is.

Shift + Copy Copies the selected text without the carriage returns (copy unwrapped).

Shift + Paste      or        Shift + Paste as quotation
Paste the selection as plain text (do not paste the style information).

Shift + Wrap Selection Removes the carriage returns from the selected text (unwraps).

Shift + Exit Sets all open windows to open again when Eudora is next started.

Shift + Save Saves changes to all open windows.

Shift + Close Closes all open windows.

Alt + k Turn on Keep on top in the Directory Services window.



Shortcuts

The keyboard shortcuts for Eudora functions are as follows:

Ctrl + 0 Open Out mailbox
Ctrl + 1 Open In mailbox
Ctrl + 6 Check Spelling
Ctrl + ' Paste as quotation
Ctrl + , Finish nickname
Ctrl + A Select all
Ctrl + B Make the selected text bold (32-bit only)
Ctrl + C Copy 
Ctrl + D Delete
Ctrl + E Send or Queue
Ctrl + F Find dialog
Ctrl + H Attach document
Ctrl + I Make the selected text italic (32-bit only)
Ctrl + J Filter messages
Ctrl + K Make nickname
Ctrl + L Address Book
Ctrl + M Check mail
Ctrl + N New message
Ctrl + O Open file 
Ctrl + P Print
Ctrl + Q Exit Eudora
Ctrl + R Reply
Ctrl + S Save
Ctrl + T Send queued messages
Ctrl + U Make the selected text underlined    (32-bit only)
Ctrl + V Paste
Ctrl + W Close message
Ctrl + X Cut
Ctrl + Y Directory Services
Ctrl + Z Undo

arrows Move from one message to another in a mailbox (depends on your Miscellaneous 
Options). 

enter Select the outlined button in any dialog, alert, or window, or open the selected 
messages or URL.

esc Stop any operation currently in progress.
F1 Display Help.
page up, page down Scroll up or down through the window.



 Win32s Compatibility

If you are running Win32s, we suggest using the 16-bit version of Eudora Pro for Windows. If you must run the 
32-bit version of Eudora under Win32s, be sure    to run Win32s version 1.3 or later.



Reporting Bugs

If you experience something you think might be a bug in Eudora, please report it by sending a message to 
<eudora-bugs@qualcomm.com>. Describe what you did, what happened, what version of Eudora you have, any 
error messages Eudora gave (the numbers in ()'s are especially important), what kind of computer you have, 
which operating system you're using, and anything else you think might be relevant.

You will receive an automated response indicating that your bug report has been received and forwarded to our 
engineering staff. Unless additional information is needed, you will not receive a direct response.



Suggestions

From time to time, everyone comes up with an idea for something they'd like their software to do differently. This 
is true of all applications, no less Eudora. If you come across an idea that you think might make a nice 
enhancement to Eudora, your input is always welcome. Please send any suggestions or requests for new 
features to <eudora-suggest@qualcomm.com>.

You will receive an automated response indicating that your suggestion has been received and forwarded to our 
engineering staff. Unless additional information is needed, you will not receive a direct response.



EUDORA.INI Settings File

The EUDORA.INI file is where Eudora keeps most of the settings.    It is a standard Windows INI file, and may be
edited with any text editor.    

Note: Since Windows caches information from INI files in memory while the program is running, you should 
never change the EUDORA.INI file while Eudora is in use.    If you need to make a change, first quit 
Eudora, then edit the file, and then restart Eudora.

The EUDORA.INI file is broken up into 5 sections:

[Settings]    
[Dialup]     
[Window Positions]     
[Debug]     
[Mappings]  

Only the items that are not configurable from the Options dialog are listed here.

Name and Location of the INI File

The default name is EUDORA.INI and the default location is in the mail directory.    But the name and location 
can be changed.

To specify a different INI file from the EUDORA.INI that is not in the mail directory, add a second parameter to the
command line in the Program Item for Eudora, e.g.

Command Line: c:\apps\eudora.exe c:\mymail c:\inis\myeudora.ini

To use a different INI file that is in the mail directory:

Command Line: c:\apps\eudora.exe c:\mymail myeudora.ini
Command Line: c:\apps\eudora.exe c:\mymail\myeudora.ini

This is a way to have multiple settings for one set of mailboxes, nicknames, etc.    For example, you may have 
multiple e-mail accounts in which you receive mail, but want to collect mail from all of the accounts in one place.   
You could set up separate Program Items for each account (each having a different INI file on the command 
line), and switching between accounts would be as simple as double-clicking on a Program Item.

And for an even more tricky specification, if the first parameter is an INI filename without a path, then the mail 
directory is searched through the normal process of checking the EUDORA environment variable and then using 
the executable directory.

Examples:

SET EUDORA=c:\mymail
Command Line: c:\apps\eudora.exe myeudora.ini

will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI file.

SET EUDORA=myeudora.ini
Command Line: c:\apps\eudora.exe



will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.

Default INI file

When an entry in the EUDORA.INI file is not found, Eudora will look in the DEUDORA.INI file located in the same
directory as the EUDORA.EXE file. The [Mappings] section of the DEUDORA.INI file acts as though it was 
appended to the end of the [Mappings] section of the EUDORA.INI file.



[Dialup]

The [Dialup] section controls the use of the dialup connection method.    See the “Dialup Eudora" appendix to the 
user manual for more detailed information.

Entry Default Value Description
ATSendDelay 100 The delay between sending characters in

a modem AT command and in the 
EchoCancelString (in milliseconds).

BreakTime 150 Length of modem break command (in 
milliseconds).

BusyRetries 0 The number of times that the phone will 
be redialed after receiving a busy signal.

BusyRetryDelay 5 The number of seconds between redials 
after receiving a busy signal.

EndScript SERIAL.END Script used when closing modem 
connection.

SMTPHELOString String to send as the parameter of the 
SMTP HELO command.

TelnetCommand telnet {System} {Port}\r\
n

Telnet command issued to use the 
network services (i.e. POP, SMTP, ph, 
finger, and Eudora password changer).

[Debug]

The [Debug] section controls aspects of the Eudora log file.    The Eudora log file is a handy tool for debugging 
network connections, especially when using the dialup connection method.

Entry Default Value Description
LogFileName EUDORA.LOG The name of the log file.
LogFileSize 100 The size of the log file (in KB) when it will be copied to 

the file EUDORLOG.OLD and a new log file will be 
started.

LogLevel 11 A bit-mapped value telling what type of information to 
log:
Bit 1    (1): Sending of a message
Bit 2    (2): Receipt of a message
Bit 3    (4): Dialup script navigation commands
Bit 4    (8): Alert messages
Bit 5 (16): Progress messages
Bit 6 (32): All bytes sent
Bit 7 (64):          All bytes received

[Mappings]

This is a sample [Mappings] section.    It is NOT a default for Eudora if you have a missing/empty [Mappings] 
section.    The [Mappings] section contains information for mapping between PC file extensions, Mac creator and 
type, and MIME type and subtype for attachment files (in that order).    Entries marked as "in" work only on 
incoming messages and entries marked as "out" work only on outgoing messages.    Entries marked "both" work 
on both incoming and outgoing messages.

For a more detailed explanation, see "Appendix D - MIME and Mappings" of the Eudora manual.

out=txt,ttxt,TEXT,text,plain
both=doc,MSWD,,application,msword
in=xls,XCEL,,,
out=xls,XCEL,XLS4,,
both=xlc,XCEL,XLC3,,



both=xlm,XCEL,XLM3,,
both=ppt,PPT3,SLD3,,
both=wp,WPC2,.WP5,application,wordperfect5.1
both=zip,,,application,zip
both=rtf,,,application,rtf
both=ps,,,application,postcript
in=eps,,EPSF,,
out=eps,dPro,EPSF,application,postscript
both=mpg,,,video,mpeg
both=jpg,,,image,jpeg
both=gif,,,image,gif
both=tif,,,image,tiff
both=pct,,PICT,,
both=mac,MPNT,PNTG,,



[Window Positions]

The [Window Position] section saves the positions of the standard windows (not your mailboxes and messages).

Entry Default Value
CheckSpellingWindowPosition 0,0,0,0
DebugTraceWindowPosition 110,185,635,500
FilterReportWindowPosition 10,10,500,300
FiltersWindowPosition 60,345,580,480
FindWindowPosition 60,345,580,480
InputDialogWindowPosition 50,100,358,450
MailboxesWindowPosition 80,80,565,415
MainWindowPosition 0,0,640,480
NicknamesWindowPosition 50,5,590,475
PhWindowPosition 10,40,630,440
ProgressWindowPosition 0,0,0,0
Signature2WindowPosition 10,60,630,240
SignatureWindowPosition 10,60,630,240
TextFileWindowPosition 0,0,600,460

[Settings]

Entry Default 
Value

Description

AutoWordSelection 0 When on, selection in text is done on 
a word boundary rather than a 
character boundary.

BadPasswordString When the POP server returns an 
error on sending the PASS 
command, the password will only
 be erased when the error response 
includes this text.

CenterUnreadStatus 1 When on (1), centers the bitmap in 
Mailbox menu items that indicates 
that the mailbox has unread 
messages.    If the display of this 
bitmap is not correct, turn this 
switch off (0).

CompactDisk% 5 What the amount of "wasted space" 
taken up by deleted messages in a 
mailbox as a percentage of total 
free disk space must be before the 
mailbox automatically gets 
compacted when closed.

CompactMailbox% 50 What the percentage of "wasted 
space" taken up by deleted 
messages in a mailbox must be 
before the mailbox automatically gets
compacted 
when closed.

CompSummaryItalic 1 Display summaries of outgoing 
messages in mailboxes other than 
Out with italics.

EnrichedSoftLine 72 Number of characters sent on a line 
before adding a soft newline when 
sending text/enriched.

EudoraPassPort 106 Default port number for the Eudora 
password changing service (epass).

ExcerptBars 2 Width (in pixels) of excerpt bars in 
messages.    Set to zero to hide 
excerpt bars.

ExcerptColors 0 If on, each excerpt gets displayed in 
a different color.

ExcerptColor1 255 RGB color value of first level of 



excerpt

ExcerptColor2 16711680 RGB color value of first level of 
excerpt

ExcerptColor3 32768 RGB color value of first level of 
excerpt

ExtraHeaders Extra headers that are sent with 
each outgoing message.

If multiple headers are to be sent, 
separate each with "\r\n".    

For example, 
"ExtraHeaders=X-Header1:
 foo\r\nX-Header2: bar".

ExtraNicknameDirs List of directories to search for 
additional nickname files.    Multiple 
directories can be entered, 
separated by semicolons (;).

FindMatchCase 0 "Match Case" checkbox in the Find 
dialog.

FindSummariesOnly 0 "Summaries Only" checkbox in the 
Find dialog.

FingerDefault 0 Tells whether or not the Ph window 
should default to finger.

FingerPort 79 Default port number for the finger 
service (finger).

FlushDiskCache 0 If on(1), Eudora will flush the disk 
write cache before sending the 
command that deletes a message 
from the POP server.    This is only 
necessary if you are using disk 
caching software (e.g. SmartDrive), 
have write caching turned on, and 
are sensitive about the unlikely 
chance that your machine may 
hang right after deleting a message 
from the POP server but before the 
write cache gets flushed.

GuessParagraphs 0 "Guess Paragraphs" checkbox in the 
Save As... dialog.

IdleTime 60 The number of seconds that Eudora 
has to be idle before it will consider 
performing an automatic mail check.

IncludeHeaders 0 "Include Headers" checkbox in the 
Save As... dialog.

Indent 5 The number of characters that the 
Indent In and Hanging Indent In 
functions will indent.

KerberosSetUserName 0 Uses KClient SetUserName() 
function to set user name in 
Kerberos system.    Turning this 
switch on may cause Kerberos 
tickets to be invalidated.

LastSettingsCategory 0 Last category that was displayed in 
the Settings dialog.

LexPath Directory in which the dictionary files 
for spell checking reside.

MainLexFiles Main dictionary files.    British 
dictionaries can be used by changing
this to sscebrc.tlx, sscebrm.clx, 
ssceamc.tlx, ssceamm.clx 

MainWindowState 1 The state of the Main Window 
(normal = 1, minimized = 2, or 
maximized = 3 ).    The state is set 
when Eudora closes, and the Main 
Window is set to this state the next 
time Eudora starts up.

NetworkOpenTimeout 60 The number of seconds Eudora will 
wait for a response to opening a 



connection before it gives up.

NicknameAddressesHeight 60 Percent of height of Nicknames 
window that the Address(es) field 
takes up.

NicknameListWidth% 33 Percent of width of Nicknames 
window that the list of nicknames 
takes up.

NoAutoSendPrecedence list,bulk When filtering incoming messages 
with precedence headers of list or 
bulk, do not automatically create new
outgoing messages.

NoSplashScreen 0 If on, the openning splash screen 
(aka About Box) will not be displayed.

NumberofTraceLines 300 The number of lines saved in the 
Trace window.

PhPort 105 Default port number for the Ph 
service (csnet-ns).

PhReturn A string that is appended to every 
Ph command before sending to the 
Ph server.    For example, 
"PhReturn=return all" would return all
fields of the records returned by the 
query, 
and "PhReturn=type=person" would 
return all matches to the query with 
the additional filter that the record is 
a person.

POPPort 110 Default port number for the POP 
service (pop3).

PrintHeaders 1 When on (1), printed messages get 
headers and footers.

QuoteEnd The string that gets inserted after the
original text of a forwarded message.
A newline is added before the string.

QuotePrefix > The string that precedes all lines of 
the original message in a forwarded 
message

QuoteStart The string that gets inserted before 
the the original text of a forwarded 
message.    A newline is added after 
the string.

ReadRecieptAsk 1 Ask user for read reciepts.

ReadRecieptNo 0 Always deny read receipts without 
prompting.

ReadRecieptYes 0 Always return read reciepts without 
prompting.

ReplyAllAttribution At %1, %2
you wrote:

Attribution line when a Reply to All is
done.

ReplyAttribution At %1, you 
wrote:

Attribution line when a Reply is done.

ReplyEnd The string that gets inserted after the 
the original text of a replied message.
A newline is added before the string.

ReplyPrefix > The string that precedes all lines of 
the original message in a replied 
message

ReplyStart The string that gets inserted before 
the original text of a replied message.
A newline is added after the string.

ReturnAddressFormat %1 < %2> Format of the From: field in outgoing 
messages.    %1 is the Real name, 
and %2 is the Return address.

SaveDialupPasswordText Where your dialup password is 
saved (in an encrypted format) if you 
have the Save Password switch 



turned on.

SavePasswordText Where your POP password is saved 
(in an encrypted format) if you have 
the Save Password switch turned on.

SendXAttachHeader 0 Do not send the full path to 
attachments in the X-Attachments 
header. 

ServerCacheSize 10 Number of servers remembered in 
Directory Services window.

ShowAllHeaders 0 Do not show all headers.

ShowProgress 1 Show/hide the Progress window

SMTPPort 25 Default port number for the SMTP 
service (smtp).

SMTPRecipientWrap 72 Column at which recipent headers 
(To: and Cc:) are wrapped when 
sending a message.

StationerySignatureRules 1 Signature precedence is as 
follows:User’s selection; Stationery’s 
signature; Personality’s signature. 
Set to 0 to put Personality’s signature
before Stationery’s.

TabooHeaders Received,
Status,
Message-Id,
In-Reply-To,
X-Priority,
Mime-Version,
Content-Type,
Content-
Transfer
Encoding,
X-Mailer,
X-UIDL,
X-400,
Precendence

A comma separated list of headers 
(without colons) that shouldn't be 
shown when the Show all headers 
switch ("Blah Blah Blah" icon) is off 
for a message.    The matching is 
done on a prefix basis, so any 
header that begins with one of 
these values will not be shown.

TabSpaces 0 If on, when the tab key is hit in the 
body of the message, spaces are 
inserted instead of an actual tab 
character.

TabStop 8 How many spaces to insert for a 
<Tab> in the body of a composition 
message.

TimeZone 16-bit Only
This should contain the time zone in 
which you are located, in the 
following format:

TimeZone=xxxnnnyyy

where xxx, yyy are timezone 
abbreviations like PST, PDT, CDT, 
and nnn is the offset in hours WEST 
of GMT (i.e those that are east of 
GMT should enter a negative 
number here).    xxx is the timezone 
during Standard Time and yyy is the 
timezone during Daylight Savings 
Time.    If you do not change your 
clocks during Daylight Savings Time, 
leave yyy blank.    Here's some 
samples:

TimeZone=PST8PDT

TimeZone=MET-1

If you don't specify a TimeZone entry,
then a Date: header will not be put in 
outgoing messages, which is fine for 
most because their mail server will 
insert the correct Date: header.    The 
moral is: if you don't get messages 
bounced because of a missing Date: 



header, then leave the TimeZone 
entry alone.

TraceWindowMask 31 Log level of information that gets 
sent to the Trace window (see the 
[Debug] section).

TocDateLeeway 2 Number of seconds that the date on 
a mailbox .TOC file can be behind 
the .MBX file that Eudora will not flag 
as being out of date. Helpful for 
network file systems.

UnreadExpires 5 The number of days after which a 
message is no longer used to 
determine if a mailbox has unread 
messages in it.

URLHelper Full path of application used to 
launch URLs.

URLHighlight 1 Display URLs in blue underline style.

UsePOPSend 0 If UsePOPSend is on, Eudora will 
send mail using the POP3 extended 
command XTND XMIT.    Since this is

an optional command for POP3, 
many POP3 servers do not support 
this command (Berkeley's popper, 
however, does).    There are pros and

cons to using POP3 to send your 
mail.    It provides a level of security 
since it requires a username/
password pair to send mail 
messages, unlike SMTP.    It is faster 
than SMTP, especially when 
checking for new mail at the same 
time.    It doesn't check for valid 
recipients until the entire message is 
sent, and some implementations 
(Berkeley's popper, for example) 
won't tell you which recipients are 
invalid and will send the message to 
the valid recipients anyway.

UserChangeLex uchange.tlx Filename of user-defined list of 
words to change when spell 
checking.

UserIgnoreLex uignore.tlx Filename of user-defined list of 
words to ignore when spell checking.

UserSuggestLex usuggest.tlx Filename of user-defined list of 
words to suggest when spell 
checking.

WordWrapColumn 76 Column in which lines are wrapped 
at in outgoing messages when the 
Word wrap switch is on.

WordWrapMax 80 Length at which a line is considered 
too long, and must be wrapped in 
outgoing messages when the Word 
wrap switch is on.



Priority popup

Specifies the priority of the message as it is displayed in the mailbox window.



BLAH ,BLAH, BLAH Icon

If this is on, all message headers (and any formatting codes) are displayed.



Trash Icon

If this is on, the next time Eudora checks the server for mail it also deletes this message from the server. 



Fetch Icon

If this is on, the next time Eudora checks the server for mail it also downloads this entire message.

You can also turn on the Trash icon so that the message is downloaded then deleted.



Subject Field

Use this field to change the subject of the message as it is displayed in the mailbox window. To change the subject, 
type the new subject in this field and press [Enter].



Signature popup

The Signature popup menu lets you automatically attach a signature file to the end of the message.

If you have a default signature set, it is displayed in the Signature popup menu, but you can change it at any time 
before you send the message.



Attachment Type popup

The Attachment Type popup menu lets you select what format documents that you attach to outgoing messages are 
encoded in: Multipurpose Internet Mail Extensions (MIME), BinHex, or Uuencode. 

MIME is best for recipients with MIME.
BinHex is most compatible with old Macintosh mailers and previous versions of Eudora.
Uuencode is best for communicating with older PC or UNIX systems.



Quoted-Printable Encoding

If this is on, quoted-printable (QP) encoding may be used when sending messages that contain long lines of text or 
special characters. When on, it is used for all attachments. It is recommended that this button always be on.



Text as Attachment

If this is on, plain text files (ASCII) are attached as normal. If it is off, plain text files are included in the body of the 
message.



Word Wrap

If this is on, carriage returns are inserted automatically when the message is sent, at roughly 76 characters per line.

It is a good idea not to include your own carriage returns within paragraphs if you have this option on. Only use 
carriage returns to create new paragraphs.



Tabs in Body

If this is on, when you press the tab key within the message body, a tab is inserted. If it is not on, when you press the 
tab key within the message body the cursor moves to the To field.



Keep Copy

If this is on, a copy of each sent message is kept in the Out mailbox (their summaries are marked with an S in the far 
left column of the Out mailbox window, indicating that they have been sent). These messages are saved until they are
deleted or transferred to a different folder.



Return Receipt

If this is on, your recipients receive a request to notify you that they received the message. 

This function does not work in all cases, depending on the e-mail application your recipeints are using.



Open Next Message

Opens the next message in the mailbox.



Open Previous Message

Opens the previous message in the mailbox.



New Text File

Opens a text window so you can create a text file from within Eudora.



Open Text File

Displays the standard File dialog so you can find and open a file.



Open Attachment

Opens an attachment in a composition window or a received message, as long as the attachment is highlighted (in a 
composition window) or the cursor is on the same line as the attachment (in a received message).



Close

Closes the current message or window.

Hold down the Shift key to close all open windows.



Save

Saves changes to the topmost window. This applies to message composition windows, signature windows, the 
Nicknames window, and the Filters window.

Hold down the Shift key to save the changes to all open windows.



Save As

Displays the standard Save As dialog so that you can save the current message to a plain text file. 

If you select several messages they are all saved as one file.



Send Queued Messages

Sends all queued messages to the mail server. 

Hold down the Shift key to display the Mail Transfer Options dialog.

Queued messages are listed in the Out mailbox with a “Q” in the status column.



Check Mail

Checks your POP server for new messages and transfers them to your PC. 

Hold down the Shift key to display the Mail Transfer Options dialog.

If a time appears in parentheses next to this command, it is the next time an automatic mail check will occur.



Print

Prints messages, a text file, a signature file, the Filter Report window, the dialup Navigation Trace window, or the Ph 
window.



Print Preview

Displays the Print Preview window for messages, a text file, a signature file, the Filter Report window, the dialup 
Navigation Trace window, or the Ph window.



Print Setup

Displays the standard Windows Print Setup dialog. 



Exit

Exits Eudora. If edited messages or windows are still open, you will be asked to save or discard your changes.

Hold down the Shift key to instruct Eudora that all currently open windows are to automatically reopen at the next 
startup.



Undo

Reverses the last editing action done on a piece of text.



Cut

Cuts the selected text and copies it to the clipboard.



Copy

Copies the selected text to the clipboard. 

Hold down the Shift key to remove the carriage returns from “wrapped” text prior to copying it to the clipboard.



Paste

Pastes the contents of the clipboard at the insertion point in a message or message header.



Paste As Quotation

Pastes the contents of the clipboard at the insertion point with quote characters at the beginning of each line to 
denote quoted text.



Clear

Deletes selected text without copying it to the clipboard



Select All

Selects the entire contents of a message or mailbox.



Wrap Selection

Inserts carriage returns at the end of each line of the current selection, in the same way Eudora does when it sends 
mail. 

Hold down the Shift key to unwrap the current selection (removes the carriage returns).



Finish Address Book Entry

Completes the partial text of a nickname in a message header field. 

Hold down the Shift key to insert the full nickname expansion in the message header field.



Insert Recipient

Inserts the chosen recipient at the insertion point.



Find... Find

Displays the Find dialog so that you can find a character string within one message, multiple messages, or even 
multiple mailboxes.



Find Again

Continues a search within the same message.



Enter Selection Command

Inserts a highlighted character string in Eudora into the Character String field of the Find dialog.



Sort by Status

Sorts the message summaries within a mailbox by status.

To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Priority

Sorts the message summaries within a mailbox by priority.

To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Attachment

Sorts the message summaries within a mailbox by attachment.

To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Label

Sorts the message summaries within a mailbox by label.

To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Sender

Sorts the message summaries within a mailbox by sender.

To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Date

Sorts the message summaries within a mailbox by date.

To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Size

Sorts the message summaries within a mailbox by size.

To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Server Status

Sorts the message summaries within a mailbox by server status.

To sort in descending order, Hold down the Shift key and use a Sort command.



Sort by Subject

Sorts the message summaries within a mailbox by subject.

To sort in descending order, Hold down the Shift key and use a Sort command.



Check Spelling

Checks current message composition windows, text files, and signature files for spelling errors. If a misspelled, 
unknown, or repeated word is found, the Check Spelling dialog is displayed with the word listed in the Unknown field.



Message Plugins

Applies the selected plugin to the selected message or text.



In

Opens the In mailbox. 

All incoming messages are stored in this mailbox until they are filtered, transferred, or deleted.



Out

Opens the Out mailbox. 

All messages you compose, save, and queue are stored in this mailbox until they are sent. Also, if the Keep copies 
option in the Sending Mail Options is on, a copy of each outgoing message is    saved in this mailbox.



Trash

Opens the Trash mailbox. 

All deleted messages are stored in this mailbox until you select Empty Trash from the Special menu. If the Empty 
Trash when exiting option in the MiscellaneousOptions is on, the Trash is automatically emptied when you exit 
Eudora. Deleting a message from this mailbox permanently deletes the message.



Your Mailbox

Opens a mailbox you have created. 



New...

Displays the New Mailbox dialog so that you can create a new mailbox or mailbox folder.



New Message

Opens a new message composition window.

To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog is 
displayed so that you can select the personality to make the message from. You can also select a stationery file to 
use.



Reply

Generates a reply message to a current incoming message. 

To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog is 
displayed so that you can select the personality to make the message from. You can also select a stationery file to 
use.



Reply to All

Generates a reply message addressed to all of the recipients of the selected message. 

To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog is 
displayed so that you can select the personality to make the message from. You can also select a stationery file to 
use.



Forward

Generates a forward message from a current incoming message. 

To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog is 
displayed so that you can select the personality to make the message from. You can also select a stationery file to 
use.



Redirect

Generates a redirect message from a current incoming message. 

The address in the From: field of the message header is that of the original sender “by way of” your address. 

To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog is 
displayed so that you can select the personality to make the message from. You can also select a stationery file to 
use.



Send Again

Reformats a message that was returned to you by the mail server so that you can send it again without including all 
of the return information. A message is typically rejected because of an error in the recipient’s address, although there
are many other possible reasons. 

To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog is 
displayed so that you can select the personality to make the message from. You can also select a stationery file to 
use.



New Message To

Opens a new message to the selected recipient. 

To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog is 
displayed so that you can select the personality to make the message from. You can also select a stationery file to 
use.



Forward To

Opens a forwarded message to the selected recipient. 

To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog is 
displayed so that you can select the personality to make the message from. You can also select a stationery file to 
use.



Redirect To

Opens a redirected message to the selected recipient. 

To use a different personality, hold down the Shift key while selecting the command. The Message Options dialog is 
displayed so that you can select the personality to make the message from. You can also select a stationery file to 
use.



New Message With

Opens a new message with the selected stationery file. 



Reply With

Opens a reply message with the selected stationery file.



Attach File

Displays a standard File dialog so that you can attach a file to the current message. Any file can be attached to and 
sent with a Eudora message.



Send Immediately

Sends the current message to the SMTP server.

You can change this command to “Queue For Delivery” so that your outgoing messages are put in a queue until you 
send them all at the same time. To do this, turn off Immediate send in the Sending Mail Options



Queue For Delivery

Saves the current message in the Out mailbox and marks it as Q (queued for delivery). Send your Queued messages
by selecting Send Queued Messages from the File menu.

You can change this command to Send Immediately so that your outgoing messages are sent out immediately. To 
do this, turn on Immediate send in the Sending Mail Options



Change... Queuing

Displays the Change Queuing dialog so that you can modify the queueing status of an outgoing message. 

Use this dialog to queue the current messages, unqueue messages, or set a time for queued messages to be sent.



Change... Status... Unread

Changes the status of the current messages to unread.



Change... Status... Read

Changes the status of the current messages to read.



Change... Status... Replied

Changes the status of the current messages to replied.



Change... Status... Forwarded

Changes the status of the current messages to forwarded.



Change... Status... Redirected

Changes the status of the current messages to redirected.



Change... Status... Unsendable

Changes the status of the current messages to unsendable.



Change... Status... Sendable

Changes the status of the current messages to sendable.



Change... Status... Queued

Changes the status of the current messages to queued.



Change... Status... Time Queued

Changes the status of the current messages to time queued.



Change... Status... Sent

Changes the status of the current messages to sent.



Change... Status... Unsent

Changes the status of the current messages to unsent.



Change... Priority... Highest

Changes the priority of the current messages to highest.



Change... Priority... High

Changes the priority of the current messages to high.



Change... Priority... Normal

Changes the priority of the current messages to normal.



Change... Priority... Low

Changes the priority of the current messages to low.



Change... Priority... Lowest

Changes the priority of the current messages to lowest.



None

Do not put a label on the current message (take off any existing label).



Change Label

Changes the label of the current messages to the selected label that you have created.



Change... Server Status... Leave

Changes the server status to Leave. The message will stay on the server.



Change... Server Status... Fetch

Changes the server status to Fetch. The message will be transferred from your POP account the next time you check
or send mail.



Change... Server Status... Delete

Changes the server status to Delete. The message will be deleted from the server the next time you check or send 
mail.



Change... Server Status... Fetch then Delete

Changes the server status to Fetch then Delete. The message will be transferred from your POP account, then 
deleted from the server the next time you check or send mail.



Delete

Transfers the current message(s) to the Trash mailbox.



In

Transfers the current message(s) to the In mailbox.



Out

Transfers the current message(s) to the Out mailbox.



Trash

Transfers the current message(s) to the Trash mailbox.



Your Mailbox

Transfers the current message(s) to the a mailbox you have created.



New...

Displays the New Mailbox dialog so that you can create a new mailbox and transfer the current message(s) into it.



Filter Messages

Runs all manual filters on the current messages. 

This is the only way that filters designated as Manual in the Filters window can be used.



Make Address Book Entry...

Creates a single Address Book entry from selected messages or Address Book entries.

If you make an Address Book entry from incoming messages, the addresses in the From fields are used. If you make
an Address Book entry from outgoing message, the addresses in the To and Cc fields are used.



Add as Recipient

Adds the highlighted e-mail address(es) to the Quick Recipient list. 

To do this, highlight one or more addresses in a message window, then select Add as Recipient.



Remove Recipient

Removes the selected recipient from the Quick Recipient list.



Empty Trash

Permanently deletes messages from the Trash mailbox. 

If the Empty Trash when exiting option in the Miscellaneous Options is on, the trash is emptied automatically when 
you exit Eudora.



Compact Mailboxes

Recovers the unused (“wasted”) space from all of your mailboxes. 

This wasted space was created when messages were deleted or transferred from the mailboxes.



Forget Password(s)

Makes Eudora forget that you have already entered your password(s) for this session. 

You will be prompted to reenter password(s) at the next mail check.



Change Password...

Displays the Password change dialog so that you can change the selected password.

This will only work if you have the necessary software on your server.



Message Plugins Settings...

Displays the Message Plugins Settings dialog so that you can setup your Message Plugins.



Filters

Displays the Filters dialog so that you can create filters that automatically sort your incoming and outgoing mail.



View Mailboxes

Displays the Mailboxes window so that you can create, rename, remove, and move mailboxes and folders.



Address Book

Displays the Address Book so that you can create, edit, or remove entries and their nicknames.

Entries can consist of mulitple addresses so that you can create mailing lists.



Directory Services

Displays the Directory Services windows so that you can access Ph and finger directory services.



New Signature 

Displays the New Signature window so that you can add a signature.



Delete Signature

Displays the Delete Signature window so that you can delete a signature.



Standard

Displays the Standard Signature window so that you can create a standard signature to be included at the end of 
your outgoing messages. 



Signature

Displays the selected Signature window so that you can create a signature to include at the end of your outgoing 
messages. 



Options...

Displays the Options dialog so that you can set Eudora options.



Cascade

Arranges all open windows in a cascade. 



Tile Horizontal

Arranges all open windows as horizontal tiles. 



Tile Vertical

Arranges all open windows as vertical tiles. 



Arrange Icons

Arranges iconified windows along the bottom of the Eudora window. 



Send To Back

Sends the active window to the back. 





Personality popup

Selects a personality.



Stationery popup

Selects a stationery file for the new message.



Retreive new mail

Transfer new mail for the personalities that have the Check mail option turned on in the Personalities Options. Or, 
as specified in the list on the right.



Include Headers

If this is on, the message’s (or the first of multiple messages) header information is included in the saved document. If
this is not checked, only the body of the message is saved.



Guess Paragraphs

If this is on, extraneous carriage returns are removed from the message(s), leaving returns only at the ends of 
paragraphs and converting multiple spaces into tabs.



Stationery

Save as a Stationery file.



Send Queued messages

Send all the queued messages (marked “Q”) in your Out mailbox.



Delete messages marked for deletion

Delete the messages on the server that are marked Delete in Eudora. This is for messages that were left on the 
server with the Leave mail on server, Skip messages over x k, or Fetch all message headers option.

To mark a message Delete, either click on the Trash icon in the message toolbar, or select Delete from the Server 
Action popup of the message summary.



Retreive messages marked for retrieval

Retrieve the messages on the server that are marked Fetch or Fetch & Delete in Eudora. This is for messages that 
were left on the server with the Leave mail on server, Skip messages over x k, or Fetch all message headers 
option.

To mark a message Fetch or Fetch & Delete, either click on the icons in the message toolbar, or select an option 
from the Server Action popup of the message summary.



Delete all messages that have been retrieved

Delete all the messages on the server that have already been transferred to the PC you are on.



Delete all messages on server

Delete all of your messages on the server. Be absolutely sure this is what you want to do because there is no way to
undo it.



Fetch all message headers to In mailbox

Retrieve the header and the first few lines of every new message. If you select this option, the messages are filtered 
but Copy and Transfer actions are not done (the message won’t leave the In mailbox). Set the Server Action in the 
message summaries to specify what you want to do with the messages the next time you check mail.

Important:    If you delete the message header, and you have the Delete from server when emptied from 
Trash option on in the Checking Mail Options, the message is gone completely from Eudora and the 
server. 



Apply Options to Personalities

Specify the personalities that you want to use with this mail transfer (hold down the Shift key to select multiple 
personalities in sequece, or the Ctrl key to select them out of sequence).



Find dialog

Use this dialog to find a character string within one message, multiple message, or even multiple mailboxes. 



Find

Initiates a new search in a current message.



Next

Continues a search until the character string is found in either the same message or one of the other messages in the
current mailbox.



Next Message

Begins a search at the next message following the current message. 

Eudora continues the search even if it has to open more than one message or a new mailbox.



Next Mailbox

Begins the search at the next mailbox following the current mailbox. 

Eudora continues the search among all messages in that mailbox and any subsequent mailboxes, including the In, 
Out, and Trash mailboxes.



Character String Field

Specifies the character string to be found. 

You can type the string into this fieldor highlight the character string you want (somewhere in Eudora), then select 
Enter Selection from the Find submenu. This automatically inserts the highlighted string into this field.



Match Case

When this is checked, Eudora searches for exact matches of the character string, including any capitalization.



Summaries Only

When this is checked, Eudora searches only only the Sender and Subject fields of message summaries as they 
appear in mailbox windows. (This is much faster than a full search).



Checking Spelling dialog

Use this dialog to check for misspellings in the body of current message composition windows, text files, and 
signature files. It includes a built-in dictionary and also allows for the creation of a custom user dictionary. 

You can set the spell checker to ignore capitalized words, words with numbers, and mixed case words, to report 
mixed case and doubled (repeated) words, and to suggest alternative spellings. 



Unknown

The unknown word is one that is not found in Eudora's    dictionary or your own custom dictionary. You can act on an 
unknown word using the buttons in this dialog. 



Change To

Gives a suggestion for the correction, and lets you enter your own text if the suggestion does not work. You can also 
click on a suggestion in the Suggestions field and it will be entered in the Change To field.

To change the unknown word to the text in the Change To field, click on the Change or Change all button.



Suggestions

Lists suggestions for the correct spelling of the unknown word. 

If the Always Suggest option is turned on (click on Options to see what options are on), all suggestions are listed 
here by default. If the option is turned off, click the Suggest button to display the suggestions.



Ignore

Leaves this occurrence of the unknown word as it is and continues the spelling check.



Ignore all 

Leaves all occurrances of the unknown word as they are and    continues the spelling check.



Change 

Changes the unknown word to the text in the Change To field.



Change all 

Changes every occurrence of the unknown word to the text in the Change To field.



Suggest 

Displays in the Suggestions field all the suggestions for the correct spelling of the unknown word. If there are no 
suggestions in the dictionary, then none are listed.

If you want the suggestions displayed automatically, click on the Options button and turn on the Always Suggest 
option.



Add

Adds the unknown word to your custom dictionary.



Edit Dictionary 

Displays the User Dictionary dialog so that you can add or delete words or clear your dictionary. 



Edit Dictionary dialog

Use the User Dictionary dialog to add words to or delete words from your dictionary, or to clear the entire dictionary.



Word:

Specifies what word is to be added or deleted from your dictionary.

You can type this into the field, or select a word from the dictionary.



Dictionary

Lists the words in your dictionary.



Add

Adds the word in the Word: field to your dictionary.



Delete

Deletes the word in the Word: field from your dictionary.



Clear

Clears the dictionary so that it is left empty.



Options

Displays the spell checking Preferences dialog so that you can set your spell checking options.



Check Spelling Preferences

Lists the six spell checking options. A check mark in the box next to the option name indicates that it is turned on.



Ignore capitalized words

If this is checked, words that start with capital letters are ignored.



Ignore words with numbers

If this is checked, words that contain numbers are ignored.



Ignore words with mixed case

If this is checked, words that contain both upper and lower case characters are ignored.



Report words with mixed case

If this is checked, words that contain both upper and lower case characters are reported and identified as Mixed case.



Report doubled words

If this is checked, words that appear twice in sequence in text are reported and identified as Doubled words.



Always suggest

If this is checked, Eudora's suggestions for the correct spelling of an unknown word are displayed    in the 
Suggestions field by default. 



New Mailbox dialog

Use this dialog to create a new mailbox.



Name the new mailbox

Enter the name of the new mailbox.



Make it a folder

If this is checked, the new mailbox is created as a folder.

The New Mailbox dialog is displayed again so that you can create a mailbox that goes into the folder.



Don’t Transfer

If this is checked, the new mailbox is created but the selected messages are not transferred into it.



Change Queueing...

Use this dialog to queue the current messages, unqueue messages, or set a time for queued messages to be sent.



Send Message:

These options specify when the selected messages should be sent.



Right Now

Sets the message to send immediately when you click the OK button.



Next Time Queued Messages are Sent

Sets the message to be sent the next time queued messages are sent.



On or after

Sets a time and date for the message to be sent. 

The message is saved in the Out mailbox with a T in the status column, just as if it were a normal queued message. 
However, the message is not sent until the specified time. For the message to be sent at the correct time, Eudora 
must be running at that time. If Eudora is not running then, the message is sent when Eudora is opened.



Time

Specifies what time the message will be sent. 

Change the default time if you want the message to be sent at a different time. The message is saved in the Out 
mailbox with a T in the status column, then sent at the specified time. For the message to be sent at the correct time, 
Eudora must be running at that time. If Eudora is not running then, the message is sent when Eudora is next opened.



Date

Specifies what date the message will be sent. 

Change the default date if you want the message to be sent at a different date.The message is saved in the Out 
mailbox with a T in the status column, then sent on the specified date. For the message to be sent at the correct time,
Eudora must be running at that time. If Eudora is not running then, the message is sent when Eudora is next opened.



Don't Send

Changes the message status from queued to saved.



Change Password

Change the password for the selected account (personality).



Enter Password

Enter the password for the selected account.



Filters

Displays the Filters window so that you can create filters that automatically sort your incoming and outgoing mail.



Filters dialog

Use this dialog    to create filters that automatically sort your incoming and outgoing mail. 

To start, click the New button. Then specify the criteria and the action. When you close the filters window, you will be 
promted to save your changes. 



Filter List

Displays the filters you have defined.

Filters are invoked from top to bottom as shown in the list. This order may be important when overlapping matches 
exist. 



Up

Moves the selected filter up in the filter list, changing the order it is invoked.



Down

Moves the selected filter down in the filter list, changing the order it is invoked.



New

Adds a new filter named “Untitled” is to the filter list. The filter is automatically named based on the information you 
enter in the Header and Matching Text fields.



Remove

Removes the selected filter from the filter list. The filter is deleted when you save changes to the Filters window.



Incoming

If this is checked, the filter is invoked on all incoming messages.



Outgoing

If this is checked, the filter is invoked on all outgoing messages after they are sent.



Manual

If this is checked, the filter is invoked only when you select Filter Messages from the Special menu.



Header

Specifies which section of the message the filter will search. You can select an option from the popup menu or enter 
one yourself. This is helpful if you want to use a header item that does not appear on the menu, such as X-Persona 
(for an alternate personality).

The «Any Recipient» option searches all possible recipient items (To, Cc, Bcc), the «Any Header» option searches 
all message headers (including hidden headers that are shown with the Blah Blah Blah option), and the «Body» 
option searches the message body.



Match Type

Specifies the type of match the filter performs when comparing the character string to the specified header. 

contains or does not contain
If the specified header item contains or does not contain the text string, filter the message.

is or is not
If the specified header item is or is not a complete match of the text string, filter the message.

starts with or ends with
If the specified header item starts with or ends with the text string, filter the message. The starts with item refers to 
the first non-whitespace character after the colon, so any spaces after the colon are ignored.

appears or does not appear
If the header item appears or does not appear in the message, filter the message (the text field is ignored). This is 
useful for filtering messages based only on the types of fields they contain.

intersects nickname
If the text string is included in a nickname (whether it is a full address or a nickname within the nickname), filter the 
message.



Matching Text

Specifies the character string that the filter searches for.

Keep this as specific and brief as possible. The greater the complexity of the search string, the less the likelihood of 
an exact match.



Conjunction

Specifies how the second criteria is to be used.

ignore
Ignore the second term; if the message matches the first term, filter the message.

and
If the message matches both the first and second terms, filter it.

or
If the message matches either term, filter it.

unless
If the message matches both the first and second terms, do not filter it. (This lets you exclude certain variations of the
first term.)



Filter Actions

None No action 

Make Status Assigns the selected status to messages. Select a status from the popup menu.

Make Priority Assigns the selected priority to messages. Select a priority from the popup menu.

Make Label Assigns the selected label to messages. Select a label from the popup menu.

Make Subject Assigns the subject to messages. Enter a subject in the text field. 

The new subject is given in the message summary in the mailbox window, but the subject is 
not changed in the message itself.

To include the text of the previous subject in your new subject, use the “&” symbol. For 
example, typing test message:& in this field results in the subject test message: previous 
subject.

Play Sound Plays the selected Sound when messages are received. Select a sound using the file dialog 
from the Sound button.

Open Opens the Mailbox and/or Message when a mesage is received. 

If you set a previous action to filter messages into a mailbox, then that mailbox is opened.

Print Prints one copy of each message.

Notify User Notifies you As normal and/or In report when messages are received. 

The As normal option notifies you based on the options have selected in the Getting Attention 
Options. The In report option notifies you by displaying a Filter Report that details what filter 
actions have been taken.

Notify Application Notifies the selected application when messages are received, and provide information from 
the message. Specify the application to use and the part of the message to be included.

Use the Browse button to select an application, or enter the commandline yourself. The 
commandline should include the path to the executable, any options, and the following 
substitution variables, separted by blank spaces:

%1 Date
%2 To
%3 From
%4 Subject
%5 Cc
%6 Filename (will contain the entire message)

For example, the commandline to send the subject of a message to a pager might look like 
this:

C:\apps\pager.exe -c %4

Forward To Forwards messages to the e-mail address. Enter an e-mail address in the text field. 

Forwarded messages are placed in the queue in the Out mailbox, and sent the next time you 
send queued messages.

Redirect To Redirects messages to the e-mail address. Enter an e-mail address in the text field. 

Redirected messages are placed in the queue in the Out mailbox, and sent the next time you 
send queued messages.

Reply With Replies to messages with the selected stationery file. Select a stationery file from the popup 
menu. 

Replies are placed in the queue in the Out mailbox, and sent the next time you send queued 



messages.

Server Options Assigns the selected server actions to messages.

The Fetch option specifies that the entire message be transferred from the server the next 
time mail is checked, and the Delete option specifies that the message be deleted from the 
server the next time mail is checked. If you select both, the message will be transferred and 
deleted.

Copy To Copies messages to the selected mailbox. Select a mailbox from the popup menu.

Transfer To Transfers messages to the selected mailbox. Select a mailbox from the popup menu.

If you you add a new Transfer To action, a dialog is displayed asking if you want to add an 
implied Skip rest action. If you do not, subsequent actions in that or other filters could cause 
the message to be transferred out of the first mailbox you transferred it to.

Skip Rest Stops filtering for the message (the message is not matched to the rest of the filters in the 
list).



Mailboxes Window

Lists all your Mailfolder and mailboxes. 

Use the right mouse button to add new mailboxes or mailfolders, rename them, and more.



Mailboxes

Use the Mailboxes window to create, rename, remove, and move mailboxes and folders.



Address Book Files and Entries

Lists all your Address Book files and entries. 

In 16-bit, files are flush against the left and the entries for each file are indented under that file.

In 32-bit, files are shown as book icons can be opened and closed by double-clicking on them.

To select multiple files and entries, hold down the Shift key and make selections in sequence, or hold down 
the Ctrl key and make selections out of sequence.



View By

Determines how the Address Book entries are displayed in the list-by Nickname, Address, Name, Postal address, 
Phone, or Fax.



New

Creates a new entry or file.

The New Nickname dialog is displayed, prompting you to name the entry. You can also put the entry on the Quick 
Recipient List or Make the entry a file.



Remove

Removes a selected entry or file from the list.



To

Creates a new message addressed to the selected entry, or adds the selected entry to the active message.

To select multiple entries, hold down the Shift key and make selections in sequence, or hold down the Ctrl key and 
make selections out of sequence.

You can also drag selected entries to the recipient fields of open messages.



Cc

Creates a new message CC’d to the selected entry, or adds the selected entry to the active message.

To select multiple entries, hold down the Shift key and make selections in sequence, or hold down the Ctrl key and 
make selections out of sequence.

You can also drag selected entries to the recipient fields of open messages.



Bcc

Creates a new message Bcc’d to the selected entry, or adds the selected entry to the active message.

To select multiple entries, hold down the Shift key and make selections in sequence, or hold down the Ctrl key and 
make selections out of sequence.

You can also drag selected entries to the recipient fields of open messages.



Expand Nickname

If this is checked, the full address(es) are inserted into the message address fields (instead of the nickname) when 
you use the To, Cc, or Bcc buttons. 



Nickname

The Nickname for the entry.



Recipient List

If this is checked, the nickname is included in the Quick Recipient List.

To put multiple entries on the Quick Recipient List, select the entries then check this option for any one of them. 



Address(es)

The e-mail addresses that are included in the nickname. 

You can use full addresses and nicknames in this field, just be sure any nicknames you use are defined in another 
entry. Separate each address or nickname with a comma or a carriage return (¿Enter). This is the only place you can 
use a carriage return to separate addresses. 

If you do not have a Name defined for the entry (in the Info tab), all of the addresses in this field will be included in 
outgoing mail.



Notes

Your notes for the entry. This information is not included in an outgoing message.



Name

The name of the entry. 

If there is more than one address for an entry, only the Name is given in the To field of outgoing messages, not the 
list of addresses. This is similar to Bcc, because the recipient list is hidden to each recipient.



Postal address

The postal address the entry. This information is not included in an outgoing message.



Phone

The phone number for the entry. This information is not included in an outgoing message.



Fax

The fax number for the entry. This information is not included in an outgoing message.



New Nickname

The New Nickname dialog lets you create a new entry for your Address Book.



What do you wish to call it?

The nickname for the new entry.



File

The file that the entry should go into.

This option is not available if you select the Make it a file option.



Put it on the recipient list

If this is checked, the entry is included in the recipient list.



Make it a file

If this is checked, a file is created instead of a new entry.



Directory Services

Use Directory Services to access two different services, Ph and Finger.

Ph and Finger inquiries will only work if you have the appropriate software running on your server.



Server button

Displays a list of servers that the active server knows about.Double-click on a server in the list to add it to your Server
field.

This is not always a comprehensive list of Ph servers. 



Server field

Lists the server from the Server field of the Hosts Options dialog. 

You can enter a different server name for this session. The next time you open the window, the server will be reset to 
the name in the Options dialog.



Command

Specifies the name or address being searched for, whether you will use Ph or Finger.



Response

Displays the server or host response.



Ph

Initiates a Ph query for the the text in the Command field.



Finger

Initiates a Finger query for the text in the Command field.



To

Adds the selected query results to the To field of a new message (opens a new message if necessary).



Cc

Adds the selected query results to the Cc field of a new message (opens a new message if necessary).



Bcc

Adds the selected query results to the Bcc field of a new message (opens a new message if necessary).



Keep on top

If this is on, when you use the To, Cc, or Bcc buttons the Directory Services windows stays active (on top of the 
message window).



Signature Name

The name of the new signature you are creating.



Signature List

Your signatures. Use the Shift key to select multiple signatures in sequence, or the Ctrl key to select entries of out 
sequence.





POP account:

Specifies the name of your account on your POP server.

For example, if your assigned login name is “justine,” and the name of the computer where you receive e-mail is 
“pop3.qualcomm.com” type “justine@pop3.qualcomm.com” in this field. (When you enter your account name here, it 
is made available in the POP account field of other Options categories.)

Note: This may or may not be your e-mail address. If your e-mail address is different than your pop 
account, put it in the Return Address field of the Personal Information Options.

A POP account is an account on a    computer that runs a Post Office Protocol version 3 (POP3 or POP) server. This 
is the account to which your e-mail messages are delivered so that Eudora can find them and transfer them to your 
PC. You must have a POP account to be able to receive mail with Eudora.



Real name:

Specifies your real name. 
Enter your name as you want it to appear in the From field of your outgoing mail messages. Your return address is 
also given in that field.



Connection Method:

These options specify the connection method, or no connection.

If you are using Eudora via TCP/IP software (e.g., a direct network connection, SLIP, or PPP), select Winsock. If you 
are using Eudora with a Unix shell account, select Dialup.



Winsock

Specifies a Winsock connection.

Select this option if you are using Eudora via TCP/IP software (a direct network connection, SLIP, or PPP).



Dialup

Specifies a dialup connection.

Do not use this option unless you are connecting to the Internet via a Unix shell account. If you are using a direct 
network connection, or SLIP or PPP software, use the Winsock option.



Offline (no connection)

Specifies no connection.

Select this option if you don't want Eudora to attempt to make any connections.



Return address:

Specifies a return address if it is different than your POP account. 

If you enter an address in this field, first test the address to be sure that mail sent to it is indeed delivered to you. If 
you use an invalid return address, no one can reply to your mail.



Dialup username:

Specifies your dialup user name.

Enter your dialup user name if it is different from your POP account. This is necessary if you are using Eudora directly
through a modem without the benefit of TCP/IP software, and you have a secondary user name for use during the 
dialup process (this might be used as your login name to a terminal server, for example). See Appendix E of your 
user manual for details regarding how this field can be used.



SMTP server:

Specifies the name of the SMTP (Simple Mail Transfer Protocol) server computer. 

Enter the name of your SMTP server if it is differnet from the machine that is running your POP server. You do not 
need a login name on this computer, but you must have access to it through your network.



Ph:

Specifies the name of the machine running your Ph server.

Enter the machine name, or leave the field blank.



Finger:

Specifies the name of the machine running your finger server.

Enter the machine name, or leave the field blank. If you leave it blank, Eudora uses your SMTP server as your finger 
server.



Check for mail every ? minutes

Specifies how often Eudora checks the POP server(s) for new mail. Any account that has the Check Mail option 
turned on in the Personalities Options is checked.

It's a good idea to set this to at least 15 minutes. Checking mail more frequently puts an unnecessary drain on your 
POP server.



Skip messages over ? K

If this is checked, messages over the specified size are downloaded with only the first few lines of the message body.
This can be useful on slow connections.

To download the entire message, click on the Fetch icon in the message and select Check Mail from the Find menu.



Send on check

If this is checked, any messages that are queued in the Out mailbox are sent when Eudora checks the POP Server 
for new mail. 



Save password

If this is checked, your password is stored in Eudora and you never have to enter it again, even if you exit Eudora and
restart. 

Only use this option if your PC is in a secure place.



Leave mail on server

If this is checked, incoming messages are transferred to your PC and also left on the server. (Normally your mail is 
transferred, then deleted from the POP server.) 



Delete from server after ? days

If this is checked, any mail left on the server (using the Leave mail on server option) will be deleted after the 
specified number of days. 

It is a good idea not to leave copies of your messages on the server indefinitely, as this will create mail storage 
problems on the server.



Determine first unread message by:

These options specify what determines an unread message.



First message not read by this machine

Specifies that any message not previously read by this machine is considered unread.



Status: headers

Specifies that any message not identified as read in the message Status: header is considered unread.



POP3 LAST command

Specifies that any message after the LAST downloaded message is considered unread. 

This method is more efficient than the Status: headers method when connecting to a POP server that supports the 
LAST command.



Delete from server when emptied from Trash

If this is checked, all messages that you have deleted from your trash mailbox are also deleted from the server.

This only applies to messages that were transferred to your PC under the Leave mail on server option. Normally 
Eudora deletes a message from the server immediately after the message is transferred.



Authentication Style

Specifies the authentication style. Ask your e-mail administrator which one is being used at your site.



 Domain to add to unqualified names:

Specifies a domain to be added to unqualified names.

An unqualified name is one that doesn't have an "@" sign followed by a domain name. If you address a message to 
someone without including their domain name, Eudora automatically adds this domain to that address. This setting 
can be used as a time-saving device when addressing large numbers of messages to users who reside in the same 
domain. 



Immediate send

If this is checked, all send options are set to Send Immediately. 

If this is not checked, messages are saved in the Out mailbox and marked “Q” (queued for delivery).

Send options include the rightmost button in the icon bar of the message composition window and the Send 
Immediately option in the Message menu.



Send on check

If this is checked, all the messages marked “Q” in the Out mailbox are sent when Eudora checks the POP server for 
new mail. 



 Default Stationery

If a stationery file is selected, new messages will be created with that stationery, and will include the toolbar settings 
for the stationery. 

If there is no stationery selected, new messages will be created with toolbar settings based on the options selected 
below the stationery popup. 



Default signature

If a signature is selected, new messages will use that signature. 

You can always change the signature for a particular message by selecting a signature from the Signature popup 
menu on the message toolbar. Your signature is automatically attached to the end of outgoing messages.



Word wrap

If this is checked, carriage returns are inserted automatically when the message is sent, at roughly 76 
characters per line. 

It is a good idea not to include your own carriage returns within paragraphs if you have this option on. 
Only use carriage returns to create new paragraphs.



May use Quoted-Printable

If this is checked, Eudora uses quoted-printable encoding when necessary, such as when messages that contain long
lines of text or special characters are sent. 

If this is not checked, quoted-printable encoding is never used.



Keep copies of outgoing mail 

If this is checked, a copy of each message you send is saved    in the Out mailbox and marked S. 

If this is not checked, Eudora moves outgoing messages to the Trash mailbox after they are sent.



Tabs in body of message

If this is checked, when you press the tab key within the message body, a tab is inserted.

If this is not checked, when you press the tab key within the message body the cursor moves to the To field.



Encoding Method:

These options specify what encoding method should be used with attached files.



MIME

If this is checked, documents attached to outgoing messages are encoded in MIME. 

MIME is best for recipients with MIME.



BinHex

If this is checked, documents attached to outgoing messages are encoded in BinHex. 

BinHex is best for recipients with old Macintosh mailers and previous versions of Eudora.



Uuencode

If this is checked, documents attached to outgoing messages are encoded in Uuencode Data Fork. 

Uuencode is best for communicating with older PC or UNIX systems.



Put text attachments in body of message

If this is checked, plain text documents that are attached to an outoing message are sent in the message body. They 
are not sent as attachments.



Attachment Directory:

Specifies what directory your incoming attachments will be put in.

To change the directory, single-click on the directory name button (the default is blank). A dialog is displayed allowing 
you to select the attachment destination directory. 

If you do not select an attachment directory, attachments are placed in your Eudora directory.



Delete attachments when emptying Trash

If this is checked, attachments are deleted when their corresponding messages are deleted from the Trash (or the 
Trash is emptied).

The attachment must be in the directory defined as the Attachments Directory. 

If you want to save an attachment but delete the message, move the attachment to another directory or leave this 
option off.



Delete automatic attachments: Never

If this is checked, automatic attachments are never deleted automatically.

Automatic attachments are attachments to automatically generated messages, such as with the Insert System 
Configuration command.



Delete automatic attachments: After sending message

If this is checked, automatic attachments are deleted automatically after the corresponding message is sent.

Automatic attachments are attachments to automatically generated messages, such as with the Insert System 
Configuration command.



Delete automatic attachments: When message emptied from Trash

If this is checked, automatic attachments are deleted when their corresponding messages are deleted from the Trash 
(or the Trash is emptied).

Automatic attachments are attachments to automatically generated messages, such as with the Insert System 
Configuration command.



Personality

A popup menu including your <Dominant> personality and any additional personalities you have defined.



New Personality

Lets you add a new personality to the personality popup.



Add / Modify Personality

If the New button is used and a personality name is entered, the Add button adds the new personality.

If an existing personality is in the popup menu and you change it, the Modify button replaces the old personality 
name with the new personality name.



Delete Personality

Deletes the personality that is in the Personality field.



Check mail

If this is checked, this account is checked when a manual or automatic mail check is done.



Screen Font:

Specifies the font and point size to be used for displaying the text of your Eudora messages and mailbox windows. 

To change the selection, click on this button. The Font dialog is displayed so that you can select a new font and size.



Print Font:

Specifies the font and point size to be used when printing messages using the Print... command.

To change the selection, click on this button. The Font dialog is displayed so that you can select a new font and size.



Message window width:

Specifies the width of new and received message windows (in characters). The default    is 80.

This setting has no effect on what your mail looks like when it is sent. When mail is sent, Eudora wraps at or before 
76 characters.

If you use a proportional font, Eudora sets the window width based on the average width of the characters in the font.



Message window height:

Specifies the height of new and received message windows (in lines). The default value is 20.

If the Zoom windows when opening option is turned on, received message window heights are automatically 
adjusted to the height of the message text.



Zoom windows when opening

If this is checked, new windows automatically sized to display their contents without empty space. 

The zoomed size is computed on a window-by-window basis. For message windows, zoomed size is just long 
enough to display all of the message (but no longer than the main window), and as wide as the Message Window 
Width setting. Composition windows zoom to the height specified by the Message Window Height setting.



Show toolbar

If this is checked, the main window toolbar is displayed.



Show toolbar tips

If this is checked, holding the mouse pointer over a button in the main window toolbar displays a very brief description
of that button's function.



Show status bar

If this is checked, a status bar is displayed at the bottom of the main window. The status bar provides a brief 
description of menu items and toolbar buttons.



Show category icons

If this is checked, the Options categories are presented with    icons and the name. 

If this is not checked, the categoris are presented with just the name.



Labels
The Labels options define the title and color of the seven labels that can be used to categorize messages. To change 
a label title, type the new title in the field to the right of the label number. To change a label color, single-click on the 
label number to display the Color dialog. 

In the Color Dialog, you can select from one of the pre-defined Basic Colors or create your own Custom Colors. To 
assign a basic color to a label, select the color and click OK. To create a custom color, click the Define Custom Colors
button to display the custom colors palette. 

To define a custom color, select one of the 16 custom color boxes. Using the mouse pointer, click anywhere on the 
color palette to select the color Hue and Saturation. Use the color control bar to the right of the color palette to adjust 
the color. When you are satisfied with the color, click the Add to Custom Colors button. Once you have completed 
creating the custom colors, select the desired label color and click OK.



Use an alert dialog box

If this is checked, an alert dialog notifies you when you have new mail.



Open mailbox

If this is checked, mailboxes are opened when new mail is received, and the first unread message is highlighted. 



Play a sound

If this is checked, Eudora plays the sound when new mail    arrives. 

To select a sound (.wav) file, click on the Play a sound button. The Select Sound File dialog dialog is displayed so 
that you can select a sound.



Select Sound File

Specifies the sound file to be played when new mail arrives. 

To select a sound (.wav) file, click on this button. The Select Sound File dialog dialog is displayed so that you can 
select a sound.



Generate Filter Report

If this is checked, a Filter Report is generated with information about filtered messages.



Delete unread mail

If this is checked, a warning dialog is displayed when you try to delete unread mail.



Delete queued mail

If this is checked, a warning dialog is displayed when you try to delete queued mail.



Delete unsent mail

If this is checked, a warning dialog is displayed when you try to delete unsent mail.



Queue a message with no subject

If this is checked, a warning dialog is displayed when you try to queue a message with no subject.



Queue a message with styled text

If this is checked, a warning dialog is displayed when you try to queue a message with styled text.



Quit with messages queued to be sent

If this is checked, a warning dialog is displayed when you try to quit with messages queued to be sent.



Queue a message bigger than ? K

If this is checked, a warning dialog is displayed when you try to queue a message bigger than the specified size.



Set a changed message back to read-only

If this is checked, a warning dialog is displayed when you try to set an incoming message back to read-only and the 
message has been changed .



Empty the Trash mailbox

If this is checked, a warning dialog is displayed when you try to empty the Trash mailbox.



Start Eudora and it's not the default mailer

If this is checked, a warning dialog is displayed when you try to start Eudora and it’s not the default e-mail application.



Map Ctrl+R to "Reply to All"

If this is checked, when you type Ctrl-r a reply message is created addressed to all the recipients of the selected 
message.



Copy original's priority to reply

If this is checked, when you do a Reply the reply has the same priority as the original message.



Automatically FCC to original mailbox

If this is checked, replies are automatically copied to the mailbox the original message is in.



When Replying to all:

These options specify how a reply message will be generated.



Include yourself

If this (and Reply to all) is checked, when you do a Reply the reply includes your address so that you receive a copy 
of your own reply. 

If this is not checked, the reply does not include your address and you do not receive a copy. (Unless you have 
checked Keep copies of outgoing mail    in the Sending Mail    category.)



Put original To: recipients in Cc: field

If this (and Reply to all) is checked, when you do a Reply the reply includes the addresses of the original message 
recipients in the Cc: field. The To: field contains only the address of the original sender.



Status

If this is checked, the Status column is displayed in Mailbox windows.



Priority

If this is checked, the Priority column is displayed in Mailbox windows.



Attachment

If this is checked, the Attachment column is displayed in Mailbox windows.



Label

If this is checked, the Label column is displayed in Mailbox windows.



Sender

If this is checked, the Sender column is displayed in Mailbox windows.



Date

If this is checked, the Date column is displayed in Mailbox windows.



Size

If this is checked, the Size column is displayed in Mailbox windows.



Server status

If this is checked, the Server status column is displayed in Mailbox windows.



Subject

If this is checked, the Subject column is displayed in Mailbox windows.



Dialup username:

Specifies your dialup user name.

Enter your dialup user name if it is different from your POP account. This is necessary if you are using Eudora directly
through a modem without the benefit of TCP/IP software, and you have a secondary user name for use during the 
dialup process (this might be used as your login name to a terminal server, for example). See Appendix E of your 
user manual for details regarding how this field can be used.



Phone number:

Specifies the telephone number for your terminal server.

Enter the number, and be sure to include any necessary prefixes to get an outside line, turn off call-waiting, etc.



Modem:

Specifies your modem type. 

Select your modem from the popup or, if your modem is not listed among those available, select *Default:Hayes 
(unreliable transfers). 

While the default modem functions in many cases, you may experience data corruption when sending or receiving 
messages. To configure Eudora for a reliable connection using the default modem, you must modify the 
SERIAL.MOD dialup file, as described in Appendix E of the user manual.



Baud rate:

Specifies your baud rate.

Select the value that corresponds with your modem speed.



COM port:

Specifies the COM port that your modem is connected to on your PC. 

Select the appropriate port.



Flow Control:

Specifies the modem flow control. 

Flow control is the ability of the modem and PC to stop the data flow before the internal buffers fill up and overflow. 
The modem may use either hardware or software flow control (software flow control is typically the modem default 
setting), but hardware is preferred and strongly recommended at baud rates above 9600. If your modem does not 
support hardware flow control, then you must use software flow control. Software flow control, however, does not 
work well at speeds above 9600 baud.



Data bits:

Specifies a terminal server setting. The default value is correct for almost all cases. Consult with your local Eudora 
support coordinator or service provider before you change this value.



Stop bits:

Specifies a terminal server setting. The default value is correct for almost all cases. Consult with your local Eudora 
support coordinator or service provider before you change this value.



Parity:

Specifies a terminal server setting. The default value is correct for almost all cases. Consult with your local Eudora 
support coordinator or service provider before you change this value.



Service provider:

Specifies the service provider whose terminal server Eudora is connecting to. 

If your service provider is listed among those available, select it. If not, select *Default (must modify).

The default service provider will not function until the SERIAL.NAV dialup file is modified to work with your service 
provider, as described in Appendix E of the user manual.



Dialup timeout after ? seconds

Specifies the number of seconds before a dialup connection will time out. The default is 60.

Change the number of seconds if you want more time before the connection will time out.



CRLF Processing

If this is checked, Eudora’s cr/lf processing is on. 

Telnet programs routinely translate carriage returns into carriage return (cr)/ linefeed (lf) pairs. For this reason, 
Eudora processes cr/lf pairs to plain carriage returns by default. If your terminal server does not translate carriage 
returns to cr/lf pairs, or you are running srialpop to establish an echoless session (as described in Appendix E of the 
user manual), Eudora's cr/lf processing must be disabled. This can be done by turning this option off.



Show trace window

If this is checked, the Trace Window is opened automatically at the beginning of the dialup session. 

The Trace Window follows what Eudora is sending, expecting, and the characters returned to Eudora. The Trace 
Window is a valuable troubleshooting tool because when there is an error during the dialup process, the window 
displays the source of the error.



Ignore capitalized words

If this is checked, words that start with capital letters, such as proper nouns, are ignored.



Ignore words with numbers

If this is checked, words that contain numbers are ignored.



Ignore words with mixed case

If this is checked, words that contain both upper and lower case characters are ignored.



Report words with mixed case

If this is checked, words that contain both upper and lower case characters are reported and identified as Mixed case.



Report doubled words

If this is checked, words that appear twice in sequence in text are reported and identified as Doubled words.



Always suggest

If this is checked, Eudora's suggestions for the correct spelling of an unknown word are displayed    in the 
Suggestions field by default. 



Ignore Original Text

If this is checked, quoted text (preceded by “>” or “|” ) is ignored.    Eudora assumes that this text was originally from 
another message, and therefore does not need to be checked. 



Check when message queue/send selected

If this is checked, the spelling in a message is checked when you queue or send the message.



Warn me when I queue/send a message without completing the spell check

If this is checked, a warning dialog is displayed when a message is queued or sent without a complete spell check.



Switch messages with:

These options specify what keys can be used to quickly open and close message windows.



Unmodified arrow keys

If this is checked, the keyboard arrow keys can be used to close the current message and open the next or previous 
message in the mailbox. 

The up or left arrow key opens the previous message; the down or right arrow key opens the next message. If this 
option is off, the arrow keys can be used to move the caret in messages.

Even if Unmodified arrow keys is on, the arrow keys do not switch messages if there is a message composition 
window topmost on the screen.



Ctrl+arrow keys

If this is checked, you can switch between open messages by holding down the [Ctrl] key and then pressing the arrow
keys.



Alt+arrow keys

If this is checked, you can switch between open messages by holding down the [Alt] key and then pressing the arrow 
keys.



Require confirmation for deletes

If this is checked, you are alerted when you delete messages you haven't read, or when you transfer queued 
messages out of the Out mailbox.



Close messages with mailbox

If this is checked, all open messages are closed when you close the mailbox they are in.



Empty Trash when exiting

If this is checked, the Trash mailbox is emptied every time you exit Eudora. 

If this is not checked, the Trash is only emptied when you select Empty Trash from the Special menu.

If you want to remove some messages from the Trash mailbox but don't want to empty it entirely, highlight the 
summaries you want to delete and select Delete from the Message menu. The selected messages are deleted.



Say OK to alerts after ? seconds

If this is checked and a number of seconds is specified, any notices of network problems are dismissed after the 
specified number of seconds.

If this is not checked, notices are left in place and Eudora cannot try the communication again until you dismiss the 
alert. 



Turbo redirect by default

If this is checked, a Redirect to Recipient command does the following:

Opens a redirected message to the selected recipient
Queues the new message
Deletes the original message

To turn this option on or off (regardless of this setting), hold down the [Shift] key while selecting a redirect recipient.



Automatically open next message

If this is checked, the next unread message is opened when you delete or transfer the current message.



Allow Drag and Drop Transfers

If this is checked, you are able to “drag and drop” messages among mailboxes.



Intercept Netscape mailto URls

If this is checked, when you click on a mailto URL in Netscape (a e-mail address link) a new Eudora message is 
opened for that address.



Include outdated ‘Return-Receipt-To’

If this is checked, the old-style Return-Receipt-To header is included with the new Disposition-Notification-To 
header.



Automatically expand nicknames

If this is checked, when you enter nicknames into message address fields the entire address(es) of the nickname is 
entered into the field, not just the nickname.



Use asynchronous Winsock calls for

These options specify how Winsock calls are made using a TCP/IP stack. If you're experiencing trouble with your 
Winsock connection, make sure both of these options are off.



All non-database functions

Specifies asynchronous Winsock calls for all non-database functions.

There are two methods of making Winsock calls using TCP/IP stacks, blocking and asynchronous. Because of the 
ability to handle error conditions more gracefully, asynchronous is the preferred method when using Eudora. 
However, some TCP/IP stacks do not handle asynchronous calls correctly. If you're experiencing trouble with your 
Winsock connection, make sure both of these options are off.



Database functions

Specifies asynchronous Winsock calls for database functions.

There are two methods of making Winsock calls using TCP/IP stacks, blocking and asynchronous. Because of the 
ability to handle error conditions more gracefully, asynchronous is the preferred method when using Eudora. 
However, some TCP/IP stacks do not handle asynchronous calls correctly. If you're experiencing trouble with your 
Winsock connection, make sure both of these options are off.



Network Open timeout ? seconds

Specifies the number of seconds before a network connection will time out.



Network timeout after ? seconds

Specifies the number of seconds before a network connection will time out.



Network buffer size of ? bytes

Specifies the size of the buffer that Eudora uses to transfer information to and from the server.

If you are having trouble transferring large messages, the size of this buffer may be decreased.



Cache network info

If this is checked, Eudora remembers the results of previous database functions when using the Winsock connection 
method. 

This speeds up database functions within a single Eudora session.



Unload Winsock DLL after closing socket

If this is checked, the Winsock DLL is unloaded after the socket is closed.

This is useful if you don’t want Eudora to keep your Winsock DLL open continuously.



Automatically dial & hangup this connection

If this is checked, the specified dialup connection (referred to in Windows NT 4.0 as a “phonebook entry”) is used 
when Eudora does any network operation. Use the popup menu of connections to be sure the Entry is correct.

This option is only available if you have installed the dialup networking services with Windows 95 or Windows NT 4.0.



Username

This specifies the username to be used with the auto connection.



Save password

If this is on, the password for the auto connection is saved in Eudora so that you do not have to re-enter it after 
exiting Eudora.

If you select Forget Password(s) from the Special menu, you will be prompted for the password the first time you try 
to check mail.



Domain

Specifies the NT domain that you normally log into.

This field can be left blank.



Use Eudora MAPI server:

These options specify when the Eudora MAPI server should run.



Never

If this is checked, the Eudora MAPI server is off and is never automatically opened.



Always

If this is checked, the Eudora MAPI server is on and is always opened on startup.



When Eudora is running

If this is checked, the Eudora MAPI server is on when Eudora is running.



Delete MAPI attachments:

These options specify when MAPI attachments should be deleted.



Never

If this is checked, MAPI attachements are never deleted.

MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you 
want to save them, use this option.



After sending message

If this is checked, MAPI attachements are deleted after their corresponding messages are sent.

MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you 
do not want to save them, use this option.



When message is emptied from trash

If this is checked, MAPI attachements are deleted after their corresponding messages are emptied from the trash.

MAPI attachments are copied into the Attach directory (or a directory you have specified) when they are sent. If you 
do not want to save them after their corresponding messages have been deleted, use this option.



Kerberos POP3 port:

Specifies the port that the Kerberos POP server is listening on.



Realm:

Specifies the network realm that the Kerberos server resides in.



Service name:

Specifies the type of service that you're requesting.



Service format:

Specifies the name of the ticket that Eudora requests from the Kerberos server.



Discard styles before sending messages

If this is checked, no style information will be sent with messages.



When receiving styles, pay attention to: Bold, Italic, Underline, Font, Size, Color, Justify, Margins, and 
Excerpts

The selected style information    will be used in displaying incoming messages (based on the styles in the message).





Address Book Files and Entries

Lists all your Address Book files and entries. 

To open and close an Address Book file (shown as a book icon), double-click on it.
To select multiple files and entries, hold down the Shift key and make selections in sequence, or hold down 

the Ctrl key and make selections out of sequence.



Mailboxes Window

Lists all your Mailfolder and mailboxes. 

Use the right mouse button to add new mailboxes or mailfolders, rename them, and more.



The Mailboxes Window

The Mailboxes window lets you create new mailboxes and folders, remove and rename them, and move mailboxes 
among folders. It is    automatically docked to the left side of the Eudora application window, and can also be docked 
to the right side of the Eudora window, or placed anywhere on your desktop. To open it, select Mailboxes from the 
Tools menu. 

To move the Mailboxes window, hold down the left mouse button on the rim of the window and drag it where 
you want it. If you drag it to the left or right edge of the Eudora window, it will dock in a vertical position in the Eudora 
window. 

To open a mailbox or folder, double-click on it. 
Creating a New Mailbox or Folder 
Renaming a Mailbox or Folder
Moving a Mailbox (or Folder) from one Folder to Another
Removing a Mailbox or Folder



Creating a New Mailbox or Folder

To create a new mailbox or folder in the Mailbox window, click the right mouse button (inside the window) 
and click New. A dialog is displayed requesting the name of the new mailbox or folder.

Type in the new name, check the Make it a Folder option if you want to, and click OK. The new mailbox or folder 
is displayed in the lists, and added to the Mailbox and Transfer menus.



Renaming a Mailbox or Folder

To rename a mailbox or folder, click on it once, then click again to highlight just the name (or click on the right mouse 
button and select Rename). Type in the new name.



Moving a Mailbox from one Folder to Another

To move a mailbox from one folder to another, select the one you want to move and drag it to where you want it. 



Removing a Mailbox or Folder

To remove a mailbox or folder, select the ones you want to remove then click select Delete from the right 
mouse button or use the Delete key.
If you choose to remove a mailbox in which messages are still stored, or a folder in which other mailboxes or folders 
are stored, all the messages, mailboxes, and folders contained within the selected mailbox are also removed.



Putting Multiple Users on One PC

To have multiple users on one PC, make a separate mail directory and create shortcuts to the Eudora executable for 
each user.    The mail directories can be named whatever you like, and put anywhere you like, including on floppies or
network drives.    To tell Eudora which directory to use, specify that directory in the Target field of your shortcut.

Specifying a mail directory



Customizing the Toolbar

The Toolbar is a group of buttons that gives you easy access to your frequently used Eudora commands. You 
can create buttons for most Eudora commands. 

To position the toolbar on the monitor, hold down the left mouse button on the bar itself (not on a button) and
drag it around until you find a place you like. You can dock it to the top or bottom of the Eudora window or put it 
anywhere on your desktop. 

To add buttons to the toolbar, click the right mouse button somewhere on the toolbar, and select Customize.
The Customize Toolbar dialog is displayed. Select a Eudora menu from the list on the left, then drag buttons from 
the list on the right down to the toolbar. 

To change the placement of a button on the toolbar, hold down the Alt key and drag the button to where you 
want it.

To remove a button from the toolbar, drag the button off of the toolbar.



Toolbar Categories

Toolbar button categories (These are the same as the Eudora menu commands).



Toolbar Buttons

The toolbar buttons available in the selected category. These are generally the commands that are available from that
menu item.



Description

A description of the last-selected toolbar button.



Formatting Text

You can use standard text editing options to format the text of your outgoing messages or text files. The 
formatting is delivered to your recipients using the “text/enriched” MIME standard, which means that the 
formatting your recipient sees depends on how well their e-mail package supports this standard. 

It is important to remember that you cannot completely control what happens on your recipient’s computer. 
Depending on the type of computer they are using, their installed fonts, their settings or preferences, etc., they 
could end up viewing something different than what you intended. Also, the formatting changes you make are 
sent to your recipient, but your default text settings are not. Any text that you did not make changes to is 
displayed using your recipient’s default text.

To format text, use the text styles buttons on the message window’s Icon bar or from the Text submenu from
the Edit menu. You can change the font, size, style, color, and the margins.



Plain

Makes the selected text plain.



Bold

Makes the selected text bold.



Italics

Makes the selected text italic.



Underlined

Makes the selected text underlined.



Fonts and Color

Displays the Font dialog so that you can change the font, size, style, and color.



Align Left

Makes the selected paragraph aligned to the left.



Align Center

Makes the selected paragraph aligned to the center.



Align Right

Makes the selected paragraph aligned to the right.



Smaller

Makes the selected text a standard point size smaller.



Bigger

Makes the selected text a standard point size bigger.



Normal

Makes the selected paragraph indented once.



Indent In

Makes the selected paragraph indented once.



Indent Out

Removes one level of indent from the selected paragraph.



Hang Indent In

Makes the selected paragraph indented once with the first line flush left.



Hang Indent Out

Removed one level of hanging indent from the selected paragraph.



Clear Formatting

Clear all the formatting from the selected text or paragraph.



Creating a Stationery File

To create a stationery file, open a new message, put the text you want into the message body, fill in the headers as 
appropriate (subject, copies, etc.), and set the toolbar with the options you want. Select Save as... from the File 
menu to display the Save As dialog. 

Select the Stationery option, then name the file and click on Save to save the file. You can delete the original 
message. 





Getting More Help

In addition to the On-line Help and user manual, here are some other ways to get answers to your questions:

Ask your E-mail administrator.

Check out the Eudora Usenet News group <comp.mail.eudora.ms-windows>.

Send mail to eudora-support-ent@qualcomm.com. Please include your registration number.

Users eligible for telephone support can call 1-800-249-2857 or 1-619-658-1939. Designated technical contacts 
are eligible for a limited period of telephone support. Please have your registration number ready.
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Getting More Help

In addition to the On-line Help and user manual, here are some other ways to get answers to your questions:

Ask your E-mail administrator.

Check out the Eudora Usenet News group <comp.mail.eudora.ms-windows>.

Send mail to eudora-support-bus@qualcomm.com. Please include your registration number.

Users eligible for telephone support can call 1-800-249-2856 or 1-619-658-1938. Designated technical contacts 
are eligible for a limited period of telephone support. Please have your registration number ready.






